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Overview 

Version 12 Revisions 

We have added numerous functionalities into the Striplog printing. The regular Striplog Title pages 
have been modified to reflect the changes in the Well Record to print both the Surface Hole Co-
Ordinates and the Bottom Hole Co-Ordinates along with the Wireline or LWD logging runs and tools 
information block. 

We have given the user the ability to print a location map in both the reports and the Striplog. 

We have also given the user the ability to print out the 5 survey views produced from the New Survey 
View Module to the Striplog printing. We have also added the ability to print the new EUB UWI format to 
the Striplog Title pages. 

We have added the ability to print all 4 Surveys views to the Print to Word format and our regular Print 
Well End Reports. 

We have added another display option on the Directional Survey Points layer (on the right click menu) 
where the user can print the survey along with the choice of displaying the TVD depth values and / or 
SS depth values or neither depth value. 

We have revised Well Record with the Bottom Hole Co-ordinates and Surface Hole co-ordinates and 
displayed these values in both the Striplog header and well end reports. 

We have added the ability to display Logarithmic curves scales in hybrid manner such as .2 to 2000 
for Resistivity curves or any hybrid display of your choice. 

We have added the ability to display the curve scales either horizontally or vertically on the right click 
menu for a curve layer in the main body of the log. The header scales are static as they were. 

We have added the ability to display the TVD and or the SSL depths for each individual survey point. 
You can modify the display from the System Options Display tab or on the right click menu selection on 
the directional survey points layer. 

We have modified the Slide / Rotate builder to accommodate Toolface orientation and we will now 
display the toolface orientation of a slide on the slide rotate layer where the S used to be displayed. If no 
Toolface is entered we will revert back to the old representation of an S. 

We have added the ability to Import Slides and Toolface orientation from a slide sheet acquired from a 
directional driller. 

We have modified the System Options - Display tab to allow the user another interface to change the 
Display options for the Survey Points. 

We have opened up all the annotation layers to all views (TVD, SS, OH & VS) so that the user can more 
easily place their annotations for the specialty views. 

We have given the user the ability to change the color of the cored interval from a solid black to any 
color the user would like. This color change allows the viewer of the log to see the start and stopped of 
the coring intervals if they were a continuous core. 

We have added the ability to create links to other data that cannot be easily displayed on the log. This 
data has to be formatted into a windows compatible display format and can be opened with a windows 
application such as a Word document, XL spreadsheet or any graphics. These links can be added to all 
of our layers. 

We have modified the casing shoe display on the casing layer to be able to scale the shoes so that on 
wide tracks they do not take over the whole track. You can find this scaling feature on the right click 
menu. 

We have added the Vertical Section (VS) module to Power*Curve. This module if purchased will 
manipulate Power*Curve depths on a click of a mouse. The user can change the depth from Measured 
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Depth (MD) to Vertical Section (VS) depth and Open Hole (OH) depth as long as the surveys have been 
calculated and the last casing string has been entered. 

We have added the Survey View module. This module if purchased will transform the survey data into 4 
separate views which you can print from the Well End reports as well as the striplog. You will get a 
detailed plan view (top down) of your well bore with respect to the survey either the DLS or NTS system 
or just a gird system. You will also get a Vertical Section (parallel to the Target Azimuth) and Cross 
Section View (right angles to the Target Azimuth) and a cube view which you can rotate by mouse pointer 
actions. All views have the ability to go right and left and up and down manipulated by your arrow keys on 
your keypad and zoom in and out using the mouse wheel on your mouse. 

When you are creating a new Well / Log using an existing log template. We have modified the Add 
Curves window to use as default the curve scales that were used in the exiting Log template. This 
should make it easier to start a new well when you have a lot of complex curve scales. 

Modified the Survey Report and Survey Points Window and reversed the E/W and N/S fields so they 
correspond to the survey data received from the Directional drillers. 

We have modified the Work Schedule window to expand the number of characters the Contractor field 
holds from 50 to 100 characters. 

We have modified the LAS Import (both right click and Import module) will now be able to accept both 
LAS Version 2 and LAS Version 3 export files. Besides curve data we will also be able to import 
Formations Tops, Surveys, Tests, Well and Drilling information which have been defined in the 
ASCII blocks in the LAS File. 

We have added a Survey Prognosis Report so the user can add the prognosed survey points (either 
manually or by importing all the data through the Directional Survey Import New Method Module. This will 
display the prognosed drilling program in the Survey View Module. 

We have added the ability to print all 4 Surveys views to the Print to Word format and our regular 
Print Well End Reports. 

We have also added the use of existing curve scales and attributes from existing logs for curves that 
are not recognized within the system curve definitions. This should make the creation of new logs much 
easier than before. 

We have added another system log for both Metric and Imperial for Gamma ray curves only. 
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File Menu – Import Export Selection 

Import / Export Selection 

LAS Import 

 
Allows you to import Log ASCII Standard (LAS) formatted files into the database. We have 
separated these import procedures into 2 sections. The first section is How to Import an LAS data 
File. The second section is How to Import an LAS data file with a saved mapping file. We now have 
the ability to Import Version 2 or 3 file formats. 

 

The user can also import a single curve into an existing curve by referring to the Right Click 

import method.  

 
If the ASCII files you receive looks like the file shown on the next page it is an LAS file. The ASCII data 
can be directly imported into the database as long as the Well exists in the database. You can now 
proceed with “How to import an LAS data File”. If it does not look similar you will have to proceed 
with “How to Import an ASCII data file”. 
~Version Information 
VERS.  3.00 :CWLS LOG ASCII STANDARD - VERSION 3.00 
 WRAP.  NO :One line per depth step 
~WELL INFORMATION 
#MNEM.UNIT  DATA   DESCRIPTION 
STRT.M   178.46040  :START DEPTH 
STOP.M   2206.44720  :STOP DEPTH 
STEP.M   0.15240   :STEP LENGTH 
NULL.   -999.22000  :Null value  
COMP.   ABC Exploration Company :Company 
WELL.   ABC et al Anywhere  :Well 
FLD.   Anywhere   :Field 
LOC.   111/09-12-015-5W4M :Location 
PROV.   Alberta   :Province 
DATE.   14-MAR-96  :Run Date 
UWI.   111012601505W400 :Unique Well ID 
LIC.   12356   :License Number 
SRVC.   Anywhere Logging Company :SERVICE COMPANY 
~CURVE INFORMATION 
#MNEM.UNIT  API CODE CURVE DESCRIPTION 
DEPT .M  00 001 00 00 : 1 Depth 
GR .GAPI  01 310 01 00 : 2 Gamma Ray 
DT .US/M  01 520 80 00 : 3 DELTA-T 
SP .MV  01 010 01 00 : 4 Spontaneous Potential 
LLD .OHMM  01 220 10 00 : 5 Latero-Log Deep (Resistivity) 
LLS .OHMM  01 220 09 00 : 6 Latero-Log Shallow (Resistivity) 
HD .MM  01 280 01 00 : 7 Hole Diameter 
TDEP .M  01 636 00 00 : 8 Tide Depth 
~PARAMETER INFORMATION 
#MNEM.UNIT  VALUE  DESCRIPTION 
RUN.   ONE  :Run Number 
PDAT.   GROUND LEVEL :Permanent Datum 
~OTHER INFORMATION 
#MNEM.UNIT  VALUE  DESCRIPTION 
~A  
DEPT    GR    DT     SP     LLD    LLS   HD   TDEP 
178.4604   52.4498   182.4146    96.9375    3.8158    0.1481    210.3713    178.46042 
178.6128   47.9652   182.4146    96.6250    3.2990    0.1484   210.3713    178.61282 

 
If the well does not exist in your database please refer to “Starting a New Log/Well” to create a new 
well so that you can import the curve data. 



                             Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 8 

How to Import an LAS data File 

If the file format is LAS V3.0 then we can import, beside curve data, Formation, Test, Inclinometry and 
Core Data directly into the database. If it is LAS V2.0 then we will only be able to import curve data. This 
method allows the user to import multiple curves at a time as opposed to the right click on a curve layer 
which allows the user to import a single curve. 
 
1. Click on the File pull down menu selection and click on Import / Export and then click on Import / 

Export LAS and then select LAS Import from the pop out-menu or simply click on the  LAS 
button, on the Toolbar, to activate the LAS Reader window. 

   
2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. 
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Overview of window 

The left hand side of the LAS Reader window (shown on the right) 
allows the user to see the tree view of the data file format including the 
different data, parameter and definition blocks. The tree enables the user 
to select different sets of data or definitions. We have the choice to import 
these data types into the predefined data sets such as curves, 
Inclinometry, Tests, Tops and Core Data within the Power*Suite 
application. We default the window to select the log data or curve data if it 
is available  
The upper right hand side of the LAS Reader window (shown below) 
allows the user to see the data associated with the different data and 
parameters and definition blocks. 

 
The middle bottom portion of the LAS Reader window (Shown below left) displays the parameters or 
data sets that have been selected from the tree view on the left. These can then be dragged to the import 
side of the LAS reader. 

     

The bottom right hand side of the LAS Reader window (shown above right) allows the user to see the 
different data sets we import as determined by the choose data type selection drop box. Curve names 
description and units for the curves as well as the curve layers associated with the log that is open and 
active at the time the LAS Reader window was invoked. 

The Choose Data Type drop box allows the user to 
import data into different tables within the Power*Suite 
application. We default this window to curves but we 
can import other data such as survey Formation, 
Surveys, Core Descriptions, Sample Descriptions, Core 
Run, DST Run and DST Period data sets. The user 
must first pick the data set from the tree and then select 
the data type so they can then map the data from the 
file to the database table. 

The Curve Depth Column drop box will appear if the curves data type is 
selected the Choose Data Type drop box which will be the default when 

the LAS Reader application is initiated. Most LAS file formats for curve data will have depth as the first 
column but this is not mandatory. We will default to the first column or a column identified with the 
standard DEPT but if it is not the depth column the user can then identify the column with the Curve 
Depth Column drop box above the columns and their descriptions. 
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The Top Base Step portion of the window appears if the curves data type is selected from 
the Choose Data Type drop box which will be the default when the LAS Reader application is 
initiated. This allows the user to import all or a portion of the of the curve data from the file 
into your open log. The user can enter new top and base depths fields to import only a 
portion of the LAS data file. This interval has do correspond to the lesser or equal to the 
depths corresponding in the data. 
 

 

 The Choose Survey Group drop box will appear if you select Surveys from 
the Choose data type drop box. This allows the user to pick a different survey 

group to import to. This survey group must be defined before the LAS Reader application has been 
initiated. 

The Choose Test Run # and Choose Test # drop boxes will appear if you 
select DST from the Choose data type drop box. This allows the user to pick 
the correct run # and test number for that run to import the data to. This The 

DST can be created before in the DST report menu or can be imported through the LAS reader by 
choosing the DST Job selection. 

The  button commences the import of data from the file that was mapped form bottom middle 
portion of the window to the data sets on the bottom right hand portion of the window. 

LAS Reader Tool Bar 

 

LAS Reader File Menu 

File Menu - Open LAS Option 

Select Open LAS file, under the File menu selection if you would like to 
open another LAS file or you did not select one when the LAS reader 

application was activated. Or, you can click on the  button on the 
Toolbar. This will activate the Open LAS file window. Navigate the folder 

structure and highlight the file you want and then click on the  
button 
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File Menu - Choose Well / Log Option 

1. Select Choose Well / Log, under the File menu 
selection if you would like to open a different Well / Log or 
you did not have a log open when the LAS Reader 

 Application was activated. Or, you can click on the 
button on the Toolbar. This will activate the Choose a log 
window 

 
2. Click on the + beside available wells to open the tree list 

of the wells in your database. 
3. Click on the dot beside the UWI of the well to show the 

list of logs available. 
4. Click on the log format (highlight) you want that has the curve layers available to import into. 

5. Click on the  button. This will open another log / well for you to import data into or 
export data out of. 

File Menu – Open Map file Option 

This allows the user to utilize the mapping file saved from the save amp file option to remap the curves / 
data to the layers or the database table fields. 

1. Select Open Map file, under the File menu selection if you would like to 
open a saved mapping file for a particular data set. Or, you can click on 

the  button on the Toolbar. This will activate the Open Map file 
window that has been saved from previous imports and they will be 
initiated by the Choose data type to import drop box selection.  

N.B. The file extensions are *.cvm for curve data, *.ftm for formation data, *.sgc for survey group data, 
*.inc for survey data, *.cdm for core data, *.tgc for DST job data, and *.tmf for DST interval data. 

File Menu – Save Map file Option 

This allows the user to save a mapping file after you have clicked and dragged the particular data from 
the LAS file to the appropriate curve layer or data type in our database table. This file is saved with a 
certain extension that we add to the mapping file name. 
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1. Select Save Map file, under the File menu selection if you would 
like to save the mapping that you have just finished for a particular 

data set. Or, you can click on the  button on the Toolbar. This 
will activate the Open Map file window that has been saved from 
previous imports and they will be initiated by the Choose data type to 
import drop box selection. 

File Menu – Export Well Option 

This allows the user to export all of the well’s data in an LAS V3.0 data format. This will export every table 
from the database very similar to the Data transfer module but not in a binary format but in a format that is 
readable by an LAS reader. 

1. Select Export Well, under the File menu selection or you can click on the  button on the 
Toolbar. This will activate the Save LAS file window. 

 

2. We will default the file name to the well name. If the file name is OK then click on the  
button. This will activate the Curve Export Options window. 

         
3. The user can modify the interval and the step if they so desire. The step may effect the curve data at 

the end of the file as they step may alter the final readings on an LAS file curve depths. We default to 

the best step available but the user can change the step and then click on the  button to 
verify the step is ok. 

We take the first curve depth from the shallowest curve and the last curve depth from the deepest of the 
curves and modify the step so that all the data will have a common step. 

4. Click on the  button when you are done. This will activate a please wait window and when the 
window disappears the file has been created in the folder you have chosen. 

File Menu – Exit Option 

This allow the user to exit the LAS Reader application 
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Importing / Mapping of LAS Curve data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 

   
2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user has the option to 
highlight different curve / log data sets from the tree list on the left of the LAS Reader window. 
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3. On the lower left side of the window Click and drag the curve you wish to import to the curve layer 
on the lower right side and release it when the layer becomes highlighted. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from 
append to replace. The Symbol color will either be purple for replace or blue for append. 

4. Repeat the Clicking and Dragging of curves to curve layers until all have been mapped. The user 
can also bring over new curves to the well without having a layer to show the curves on. You would 
then have to associate that curve to a new layer at a later date. This would be done through the log 
configuration builder on adding a new curve layer. 

 
5. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS Curve 
data again. 

6. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

7. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS curve data from a mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 
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the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 

   
2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user has the option to 
highlight different curve / log data sets from the tree list on the left of the LAS Reader window. 

 
3. Select Open Map file, under the File menu selection if you would like to open 

a saved mapping file for a particular data set. Or, you can click on the  
button on the Toolbar. This will activate the Open Map file window that has 
been saved from previous imports and they will be initiated by the Choose data 
type to import drop box selection. 
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N.B. The file extensions are *.cvm for curve data, *.ftm for formation data, *.sgc for survey group data, 
*.inc for survey data, *.cdm for core data, *.tgc for DST job data, *.tmf for DST interval data *.sdm for 
sample descriptions and *.cdm for Core Description data. 

 
4. Select the mapping file with the *.cvm saved from previous imports of similar data to similar logs and 

click on the  button. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from 

append to replace. 

5. The user can map more curves on the left side of the window by clicking and dragging the curve 
you wish to import to the curve layer on the right side and release it when the layer becomes 
highlighted. 

6. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

7. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of LAS Formation Top data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Formation Top data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Formations from the Choose Data type drop box. 

4. On the lower left side of the window click and drag the Formation top data you wish to import to the 
formation data type field on the lower right side and release it when the data field becomes 
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highlighted. Mandatory fields are highlighted in a yellow symbol  and must be mapped for the 
record to exist in the database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

5. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for 
formation tops until all have been mapped. 

 
6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS 
Formation top data again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window  
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Import LAS Formation Tops data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 

   
2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Formation Top data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Formations from the Choose Data type drop box. 

4. Select Open Map file, under the File menu selection if you would like to 
open a saved mapping file for a particular data set. Or, you can click on 
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the  button on the Toolbar. This will activate the Open Map file window that has been saved 
from previous imports and they will be initiated by the Choose data type to import drop box selection. 

N.B. The file extensions are *.cvm for curve data, *.ftm for formation data, *.sgc for survey group data, 
*.inc for survey data, *.cdm for core data, *.tgc for DST job data, and *.tmf for DST interval data. 

 
5. Select the mapping file with the *.ftm saved from previous imports of similar data to the database and 

click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

6. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of LAS Inclinometry (Group) data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Survey group data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Survey Group from the Choose Data type drop box. 

4. On the lower left side of the window click and drag the Survey group data you wish to import to the 
survey group data type field on the lower right side and release it when the data field becomes 
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highlighted. Mandatory fields are highlighted in a yellow symbol  and must be mapped for the 
record to exist in the database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

5. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for the 
survey data until all have been mapped. 

 

6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS 
Inclinometry data (survey data) again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Survey Group data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Inclinometry data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Surveys Group  from the Choose Data type drop box. 

4. Select Open Map file, under the File menu selection if you would like to open a saved mapping file 

for a particular data set. Or, you can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports and they will be initiated by the 
Choose data type to import drop box selection. 
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5. Select the mapping file with the *.sgc saved from previous imports of similar data to the database 

and click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

6. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of LAS Inclinometry (survey) data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 

   



 Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 25 

2. This will then activate the Open window which allows the user to select the LAS file you wish to 
import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Inclinometry data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Surveys from the Choose Data type drop box. 

4. Select the survey group you wish to import the data into from the Choose Survey group drop box 

5. On the lower left side of the window click and drag the Survey data you wish to import to the 
survey data type field on the lower right side and release it when the data field becomes highlighted. 

Mandatory fields are highlighted in a yellow symbol  and must be mapped for the record to exist in 
the database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

6. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for the 
survey data until all have been mapped. 
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7. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS 
Inclinometry data (survey data) again. 

8. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

9. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Inclinometry data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Inclinometry data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Surveys from the Choose Data type drop box. 

4. Select the survey group you wish to import the data into from the Choose Survey group drop box 

5. Select Open Map file, under the File menu selection if you would like to open a saved mapping file 

for a particular data set. Or, you can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports and they will be initiated by the 
Choose data type to import drop box selection. 
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6. Select the mapping file with the *.inc saved from previous imports of similar data to the database and 

click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

7. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

8. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

9. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of Core data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 
import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
Core data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Cores from the Choose Data type drop box. 

4. On the lower left side of the window click and drag the Core data you wish to import to the core 
data type field on the lower right side and release it when the data field becomes highlighted. 

Mandatory fields are highlighted in a yellow symbol  and must be mapped for the record to exist in 
the database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

5. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for the 
core data until all have been mapped. 
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6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS Core 
data again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Core data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
core data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select Cores from the Choose Data type drop box. 

4. Select Open Map file, under the File menu selection if you would like to open a saved mapping file 

for a particular data set. Or, you can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports and they will be initiated by the 
Choose data type to import drop box selection. 
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5. Select the mapping file with the *.cdm saved from previous imports of similar data to the database 

and click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

6. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of Drill Stem Test (DST) data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 
import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
DST data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select DST Job from the Choose Data type drop box. 

4. On the lower left side of the window click and drag the DST data you wish to import to the core data 
type field on the lower right side and release it when the data field becomes highlighted. Mandatory 

fields are highlighted in a yellow symbol  and must be mapped for the record to exist in the 
database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

5. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for the 
DST data until all have been mapped. 
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6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS DST 
data again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Drill Stem Test data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
core data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select DST Job from the Choose Data type drop box. 

4. Select Open Map file, under the File menu selection if you would like to open a saved mapping file 

for a particular data set. Or, you can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports and they will be initiated by the 
Choose data type to import drop box selection. 
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5. Select the mapping file with the *.tgc saved from previous imports of similar data to the database and 

click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

6. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import / Map - Drill Stem Test (DST) period data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 
import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
DST period data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select DST from the Choose Data type drop box. 

4. If the Data has the Test Run # and the Test # we can map those over. If not then we have to choose 
the Test Run # and the Test # from their respective drop boxes. 

5. On the lower left side of the window click and drag the DST data you wish to import to the core data 
type field on the lower right side and release it when the data field becomes highlighted. Mandatory 

fields are highlighted in a yellow symbol  and must be mapped for the record to exist in the 
database. 

N.B. The user can remove the mapping by right clicking on the data field and selecting remove mapping. 

6. Repeat the Clicking and Dragging of LAS field data to the data fields of the database table for the 
DST data until all have been mapped. 
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7. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS DST 
data again. 

8. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

9. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Drill Stem Test period data with a Mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. The user must highlight the 
DST period data set from the tree list on the left of the LAS Reader window. 

 
 

3. Select DST from the Choose Data type drop box. 

4. If the Data has the Test Run # and the Test # we can map those over. If not then we have to choose 
the Test Run # and the Test # from their respective drop boxes. 

5. Select Open Map file, under the File menu selection if you would like to open a saved mapping file 

for a particular data set. Or, you can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports and they will be initiated by the 
Choose data type to import drop box selection. 
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6. Select the mapping file with the *.tmf saved from previous imports of similar data to the database and 

click on the  button. 

N.B. The user can Right click on the Data field to remove the mapping. 

7. The user can map more data on the left side of the window by clicking and dragging the data you 
wish to import to the data field on the right side and release it when the layer becomes highlighted. 

8. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

9. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of LAS Sample Description data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. Highlight the Sample 
Description data set from the tree list on the left of the LAS Reader window. 

 
3. Select Sample Description from the Choose Data type drop box. 

4. On the lower left side of the window click and drag the Sample Description Data in the LAS file you 
wish to import to the sample description table data field on the lower right side and release it when 
the data field becomes highlighted. 

N.B. The user can Right click on the Data Field to remove the mapping. 
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5. Repeat the Clicking and Dragging of the data to the database table until all the data has been 
mapped. The user can then use the Sample description report to manipulate the data or the Sample / 
Core description transfer option to place the description onto the log. 

 
6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS Curve 
data again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Sample Description data from a mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. Highlight the Sample 
Description data set from the tree list on the left of the LAS Reader window. 

 
3. Select Sample Description from the Choose Data type drop box. 

4. Select Open Map file, under the File menu selection if you would 
like to open a saved mapping file for a particular data set. Or, you 

can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports 
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and they will be initiated by the Choose data type to import drop box selection. 

N.B. The file extensions are *.cvm for curve data, *.ftm for formation data, *.sgc for survey group data, 
*.inc for survey data, *.cdm for core data, *.tgc for DST job data, *.tmf for DST interval data *.sdm for 
sample descriptions and *.cdm for Core Description data. 

 
5. Select the mapping file with the *.sdm saved from previous imports of similar data and click on the 

 button. 

N.B. The user can Right click on the Data Field to remove the mapping 

6. The user can map more data on the left side of the window by clicking and dragging the data type 
you wish to import to the data field on the right side and release it when the field becomes 
highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Importing / Mapping of LAS Core Description data. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. Highlight the Core Description 
data set from the tree list on the left of the LAS Reader window. 

 

3. Select Core Description from the Choose Data type drop box. 
4. On the lower left side of the window click and drag the Core Description Data in the LAS file you 

wish to import to the core description table data field on the lower right side and release it when the 
data field becomes highlighted. 

N.B. The user can Right click on the Data Field to remove the mapping. 
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5. Repeat the Clicking and Dragging of the data to the database table until all the data has been 
mapped. The user can then use the Sample description report to manipulate the data or the Sample / 
Core description transfer option to place the description onto the log. 

 
6. The user can save this mapping procedure at this time by clicking on 

the  button or click on the File menu and Select the Save map 
file option and giving this procedure a file name and folder to be used 
again at a later date when you would have to import similar LAS Curve 
data again. 

7. Click on the  button. You will then be prompted with a system 
message after the import has finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Import LAS Core Description data from a mapped file. 

1. With your well open in Power*Log / Curve or Core Click on the File pull down menu selection and 
click on Import / Export and then click on Import / Export LAS and then select LAS Import from 

the pop out-menu or simply click on the  LAS button, on the Toolbar, to activate the LAS 
Reader window. 
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2. This will then activate the Open window which allows the user to select the LAS file you wish to 

import the data from. Find the file and directory and highlight the file by click on it once and then 

click on the  button. If your log is open at the time you will see something similar to the 
window shown below. We will default to the importing of Curve data. Highlight the Core Description 
data set from the tree list on the left of the LAS Reader window. 

 

3. Select Core Description from the Choose Data type drop box. 
4. Select Open Map file, under the File menu selection if you would 

like to open a saved mapping file for a particular data set. Or, you 

can click on the  button on the Toolbar. This will activate the 
Open Map file window that has been saved from previous imports 
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and they will be initiated by the Choose data type to import drop box selection. 

N.B. The file extensions are *.cvm for curve data, *.ftm for formation data, *.sgc for survey group data, 
*.inc for survey data, *.cdm for core data, *.tgc for DST job data, *.tmf for DST interval data *.sdm for 
sample descriptions and *.cdm for Core Description data. 

 
5. Select the mapping file with the *.cdm saved from previous imports of similar data and click on the 

 button. 

N.B. The user can Right click on the Data Field to remove the mapping 

6. The user can map more data on the left side of the window by clicking and dragging the data type 
you wish to import to the data field on the right side and release it when the field becomes 
highlighted. 

7. Click on the  button. You will then be prompted with a system message after the import has 
finished. 

 

8. Acknowledge the Finished Import message. Click on the  button and then click on the 

 button to exit or click on the File menu and select the Exit option to close the LAS Reader 
Window. 

Slide Data Import 

This method will allow the user to import ASCII, space, comma or tab delimited file formats into our 
database. We cannot import EXCEL or any other type of spreadsheet format. If the data comes that way 
you must resave it in another format before attempting to import the data. 

Importing Slide Data 

 
1. To access the Slide Data Import window, click on Import / Export under File to activate the pop-out 

menu and then select Import Slide Rotate or click on the   Import Slide Rotate data button 
on the Import Toolbar. This will activate the open Slide Data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either 

double click on the file name or click once and click on the  button. This will activate 
the Set delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown 
correctly the Example should read <column-break> between the data columns. If you see this then 

click on the  button to close this window and activate the Slide Import Options window 
shown below. 

 
4.  The user must have some knowledge of the slide data as far as the Toolface orientation is 

concerned. Select the appropriate data format for the Toolface data by click on the appropriate 

Radio Button and then click on the  button. This will activate the Slide Rotate Data 
Import window shown below. 
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Overview of the window. 

The left hand side of the Slide Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Slide Data Import window allows the user to see the data fields associated 
with the Dip Meter Table supplied by Power*Suite. 

 Button allows the user to open another Slide data file after the Import window has been 
opened. 

 Button allows the user to utilize the mapping file saved from above to remap data 
columns in the Slide data file to database fields in the Slide table in the database. 

 Button allows the user to save the mapping between data columns in the Slide data file 
to database fields in the Slide table in the database. Once the initial mapping has been done and saved, 
the user can utilize this mapping file so you do not have to repeat the clicking of dragging of data columns 
to database fields in the dip meter table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the slide data 
file to database fields in the Slide table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly 
make changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 
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Importing / Mapping of Slide data. 

A Slide / Rotate Layer should already have been added through the Log configuration builder so that the 
user can see their imported Slide data. 

 
1. On the left side of the window Click and drag the data column you wish to import to the 

corresponding table field on the right side and release it when the field becomes highlighted. If 

mapped the field  will turn green on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have 
been mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button 
and giving this procedure a file name and folder to be used again at a later date when you would 
have to import this data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to 

exit or click on the  button to close the Window. 
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How to Import Slide Data with an Existing mapping file. 

1. To access the Slide Data Import window, click on Import / Export under File to activate the pop-out 

menu and then select Import Slide Rotate or click on the   Import Slide Rotate data button on 
the Import Toolbar. This will activate the Open Slide Data file window as shown below. 

    
2. Select the file from the folder or drive with the corresponding navigational tools provided and either 

double click on the file name or click once and click on the  button. This will activate 
the Set delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown 
correctly the Example should read <column-break> between the data columns. If you see this then 

click on the  button to close this window and activate the Slide Import Options window 
shown below. 

 

4.  The user must have some knowledge of the slide data as far as the Toolface orientation is 
concerned. Select the appropriate data format for the Toolface data by click on the appropriate 

Radio Button and then click on the  button. This will activate the Slide Rotate Data 
Import window shown below. 
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5. In the upper portion of the window click on the  button. This will activate an open 
file window. 

 

6. Select the mapping file with the *.sld saved from previous imports of similar Slide data files to your 

slide table by highlighting the file and clicking on the  button or double clicking on the 
file name. Once the file has been opened it will refresh with the current mapping configuration as 
shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

7. The user can map more data columns on the left side of the window by Clicking and dragging the 
column you wish to import to the field on the right side and release it when the layer becomes 
highlighted. 
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6. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

7. Acknowledge the Import message. Click on the  button and then click on the  to 

exit or click on the  button to close the Window. 
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Slide / Rotate Export 

This utility will create an ASCII file, or a comma delimited file for the slide rotate intervals of the log / well 
that is active at the time of the export. 
 

1. The first step in creating an ASCII or a comma delimited 
file is to select ASCII Export from the File menu 
selection. Then select the Slide / Rotate Export from 
the ensuing pop-out menu. This will open the Slide 
Rotate Export Option window shown below. 

 

2. Activate the Radio Button beside the Toolface 
Orientation option you want for your ASCII export. Click 

on the  Button This action will open the 
Specify File Name window. 

3. Type in a file name (without extension) and select the drive and directory you wish the file to be 

exported to. Then click on the  button. This will activate a System Info – Slide / Rotate 
Extract window. 

4. The System Info – Slide / Rotate Toolface Extract Window will notify you that a file called (file name 
from step 3) will be create in directory (directory specified in step 3). Do you wish to proceed? Click 

on the  button to initiate the export. 
5. The file will be found in the location where was directed and can be opened in notepad / wordpad or 

into an Excel spreadsheet. 

Print Log 

 
Prints all or part of your log/well along with the Title page, location map, legends, survey views, 
individualized cores and formation tops on a continuous or single sheet basis 

1. Under the File menu selection, click on Print Log or click on the  Print button on the Toolbar 
to activate the Print Log window shown below: 

Note: The Title bar and all depths associated with the Print Log window are defaulted to the Depth View 
that Power*Log is in at the time of the activation of the Print Log window. 
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2. Select the appropriate paper orientation from this drop box 
field and the Title Page, Legend, and Formation Tops will automatically conform to the selected 
orientation. There are four (4) types of paper orientation to choose from: letter portrait or landscape 
and legal portrait or landscape settings. 

Note: The letter or legal landscape or portrait settings selected from within the Print Log window 

will NOT override the paper orientation settings selected in the printer's Properties window. Therefore, 

you must also modify the paper orientation settings in your printer's Properties window to letter or legal 

landscape. 

3.  Activate this check box , if you wish to printout a full Wellsight Version of the 
Title Page. 

4. If you are printing the Striplog Title page and you are in Alberta the EUB format 
should be selected. 

5.  Activate this check box , if you wish to printout an abbreviated version of the 
Core Log Title Page. 

6.  Activate this check box , if you wish to printout an abbreviated version of the 
Core Log alternate title Page. 

7.  Activate this check box , if you wish to printout an abbreviated version of the 
Sample Log Title Page. 
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8. Activate this check box , if you wish to printout a logo, and then select a logo 
from the Logo drop box field. 

Note: This must be a bitmap image file (*.bmp) if you want a logo printed out on the title page. Also, it is 

recommended that the bitmap image should be a square image, because Power*Suite will shrink or 

expand the image to fit the logo space on the Title Page. This bitmap must be placed in the 

Powersuite_V12\logo directory for the application to find it. 

9. Type any pertinent comments into the Title Page Remarks field and they will be displayed 
accordingly on the Strip Log Title Page only. 

10.  Activate this check box , if you 
wish to printout a location map following the title page, and then the user select a location map from 

your computers drives by clicking on the  and finding the file you want to print out as a location 
map. 

Note: This must be a bitmap image file (*.bmp) if you want a location map to be printed out. Also, the 

bitmap image must be a square image, because Power*Suite will shrink or expand the image to fit the 

location map space following the Title Page. This bitmap can be placed anywhere as the file location is 

saved within the Power*Suite ini file. 

11. Survey views  Activate this check box , if you wish to have the plan view (view of the well 
bore from surface) printed out in the striplog header as captured in the Survey View application. 

12. Survey views  Activate this check box , if you wish to have the user defined view 
(view of the well bore as manipulated by the user) printed out in the striplog header as captured in the 
Survey View application. 

13. Survey views  Activate this check box , if you wish to have the azimuth view (view of 
the well bore along the target azimuth) printed out in the striplog header as captured in the Survey 
View application. 

14. Survey views  Activate this check box , if you wish to have the cross section view 
(view of the well bore at right angles to the target azimuth) printed out in the striplog header as 
captured in the Survey View application. 

15. Survey views  Activate this check box , if you wish to have all the views printed out in 
the striplog header as captured in the Survey View application. 

16.  Activate this check box , if you wish to have our entire legend printed out. 

17.  Activate this check box , if you wish to have the legend reflect only the 
symbols printed on the log or core portions of the printed intervals defined in the log and core portions 
of the print log window. 

In the Log portion of the Print Log window 

18. Select or type in the Scale for the main log to be printed out at, in the Scale 
drop box field. 

Note: If you see 2” or some other inch related printing scale and you want to see a ratio type scale 

Change the System Options under the Options pull down menu and activate the Display Tab and Activate 

this check box  beside Use Metric Style Scales. 

The Well Section interval is derived from the Top and Base Depth values entered into the Print 

Sections window under the Edit pull down menu. (see Print Sections). 

The Lithology Section interval is derived from what has been drawn into the interpretive lithology track of 

the well that is being printed. 

19.  Activate this check box  to have the track headers printed out with the main log. 

20.  Activate this check box  to have the track footers printed out with the main log. 
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21.  Activate this check box  to have the core 
accessories printed out on the main log. 

22. Highlight the main log printing options in the selection box. The 
user can select either None, User-defined Interval (requires that 
you manually enter the desired print interval depths), Today 
Section, Well Section, or Lithology Section. 

 

Note: Today Section interval is derived from the From and To Depth values entered into the Today’s 

Section portion of the Power*Log Data Transfer: Export window. 

The Well Section interval is derived from the Top and Base Depth values entered into the Print 

Sections window under the Edit pull down menu. (see Print Sections). 

The Lithology Section interval is derived from what has been drawn into the interpretive lithology track of 

the well that is being printed. 

23. If user defined interval is chosen the user can select which depth type, either measured depth, true 
vertical depth or subsea level depth from the depth measurement drop box. The user must also type 
in the depth interval to be printed. 

Note: The log itself must be displayed in whatever depth view you wish to print before you activate 

the print log window. To change the log to the desired format, refer to depth view under the view 

pull down menu. 

In the Cores portion of the Print Log Window 
24. If you are printing out a Core log on the tail of the striplog, select the Cores you wish to print by 

highlighting them. 

25.  Select or type in the Scale for the core log to be printed out at in the Scale 
drop box field. 

26.  Activate this check box  to have the track headers printed out with the core log. 

27.  Activate this check box  to have the track footers printed out with the core log. 

Note: A separate Header Information Box is automatically printed out with every Core and includes the 

Core Scale, Core Date, Core Number, Cored Interval, Amount Cut, Amount Recovered, and 

Percentage. 

**A value must be entered into the Core Scale field in order to printout anything. ** 

28.  Activate this check box  if you wish to printout Formation Tops and the 
Formation Tops will be included on a separate page at the end of the log printout. 

 

 The page margin field is available, primarily, when you are printing to Adobe Acrobat 
writer. When a numerical value in inches is typed into this field it will initiate a top and left margin for the 
templates (Title Page, Legend and Formation Tops) as well as a left margin for the main log. 

 Activate this check box  if you are printing on single sheets. This will force the printer to 
include an additional 1/4 inch of the log at the top and bottom of each page, so that you can cut-and-
paste pages manually, if you so desire. 
 

Default Activating the default radio button  forces Power*Log / Core & Curve to use a raster or bitmap 
graphic printing method. This printing method is generally used with Laser printers 
but not exclusively so. 

Meta File Activating the Meta File radio button  forces Power*Log / Core & Curve 
to use the meta file technology printing method. This printing method was 

developed for the newer models of printers on the market today as well as using the Adobe Acrobat 
Distiller or pdf printing technology. 
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Auto Activating the Auto radio button  forces Power*Log / Core & Curve to use the settings from the 
printer driver to printout the log. 

Color Activating the Color radio button  forces Power*Log / Core & Curve to 
override the printer driver settings and consequently Power*Log / Core & Curve 
assumes that you are using a color printer. 

Mono Activating the Mono radio button  forces Power*Log / Core & Curve to 
override the printer driver settings and consequently Power*Log / Core & Curve assumes that you are 
using a monochrome (black and white) printer. 

29. Click on the  button to activate the Print Setup window and confirm that the correct 
printer settings are in effect. 

Note: If you are printing out logs in color, you must activate the Diffusion or Error Diffusion option 

normally found under Graphics in the Properties window for most printers. 

30. Interval per page field indicates how many meters of log will fit on a page of selected paper size and 
orientation selected in the setup as well as what log scale you are printing at. This will help indicate to 
the user how many pages will be required by the print job. 

31.  Activate this check box  if the user wishes to have a blank page before the logs 
starts. This could be useful if utilizing continuous paper when you want the title page oriented on the 
correct side of the prefolded paper. 

32. When you are ready to print your log, click on the  button. 

Note: If you do exit from the Print Log window, you will be asked if you wish to save the print settings. If 

you click on Yes, the program will remember every setting that you made to the Print Log window and 

then will default to those settings the next time you enter the Print Log window 

Print Well End Report 

Prints the reports for the end of a well 

Under the File menu selection, select Print Well End Report or click on the  Well End Report 
button on the Toolbar to activate the Print Well End Report window shown below: 



                             Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 60 

 



 Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 61 

Printing a Well End Report… 
1. Select the printing destination from the Output field (in the upper left corner of the Well End 

Report window), drop box arrow: Printer, Preview, or Disk File. The Preview option allows you to 
see what your report looks like before it is printed. Note, however, that the Preview option will only 
preview one report at a time. Accordingly, when you wish to preview a specific report, please be sure 
that no other reports are selected / highlighted. 

Note: To select or configure a specific printer, click on the  button. 

2. If printing to a Disk File (on your hard drive or to a flash drive), select the file format from the Disk 
File Format field drop box arrow. 

3. If the default well is not the well you want to print from then you can select a Well for printing by 

clicking on the  button and then double click on the desired Well from the ensuing Well List 
window. Please note that you may select numerous Wells, from the Well List window, for printing. 
Once you have selected your Well(s), you will then be returned to the Well End Report window 

Note: Only the selected / highlighted wells and their selected/highlighted reports will be printed** 

To highlight a Well, click on it. To remove a Well from the Well List field, highlight the Well and then 

click on the  button. To remove all Wells from the Well List field, click on the  button. Note 
that these buttons will not remove any of the Wells from the database. These buttons will only remove the 
Wells from the list of Wells currently available for printing. 

4. Select/highlight and/or deactivate any of the reports in the Reports field by clicking on them once. 

To select/highlight all of the reports, click on the  button. To deactivate all of the reports, click 

on the  button. 

Note: Daily Drilling Summary Report Update… If your Daily Drilling Summary Report is not up-to-

date or is missing Progress and Average P.R. (Penetration Rate) data you must select Print Morning 

Report under File on the Selection Bar. This will activate the Print Morning Report window, then exit 

from the Print Morning Report window (without performing any tasks), and return to the Well End 

Report window to printout your newly updated Daily Drilling Summary Report. 

5. If you are printing Sample Descriptions, you may print all or a portion of the descriptions. To print all 

of the intervals, activate the All check box . To print specific intervals only, enter the start and 
end points, i.e. Measured Depth intervals, in the appropriate interval fields and then deactivate the 

All check box . 

6. If you are printing the Title Page, click on the  button and fill in the required information. 
This information is only used on the Title Page of the report. 

Note: In order to have the Formation Evaluation Report printed out, there are two fields that must be 

filled in on your Well Formation window. These are the Boundary Type field and the Period field. If 

these two fields are left blank, the Formation Evaluation Report for that Formation will not be printed 

out. 

7. Click on the  button to activate the Report Format window shown below: 

 
8. Using the Format field drop down arrow, click on the style of Report Format that you wish to use. 

Then, click on the  button, when you are finished. 

Note: Report Formats are useful when you are printing reports for various clients, who prefer specific 

Report Formats. The formats store reports in their own directories. 
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9. If you only want to printout a Table of Contents, activate the Table of Contents Only check box  
and then make sure that the reports you want to include on the Table of Contents are 
selected/highlighted. 

Note: You can start printing at any page by typing the page number in the Start Printing at Page # 

field. 

10. The user has a choice of paginating by section number (18 – 1, 2, 3 etc), or paginating by section 
name (Sample Description – 1, 2, 3 etc). The Table of Contents will reflect these choices if you print 
the table of Contents with all the reports at the time of printing. 

11. The user also now has the choice of paginating the reports continuously pages 1 - infinity, and with 
this option you can also use the start printing at page # option. 

12. Click on the  button and then select the 8.5” x 11” Portrait paper size. 

13. Click on the  button.  
14. If you are printing to a disk file you will then be prompted with a Save As window will pop up. Type 

in a filename and click on the  button. Power*Log / Core & Curve™ will then attach an 
extra two (2) characters to the end of your filename--preceding the standard three (3) character file 
extension. The two (2) characters added by Power*Suite™ on to the end of the filename that you 
have typed in are used as a reference by Power*Suite™ to distinguish which reports are to be 
included in the file you are creating. Finally, the standard three (3) character file extension following 
the dot or period, will be selected according to the file format you selected in the Disk File Format 
field, e.g. Ascii documents will use the *.txt file extension. 

Note: If you want to print to MS Word then please select the Print to Word option under the File pull 

down menu. The Survey views cannot be printed to a disk file or to preview. They can only be 

printed to a directly to a printer or to a pdf file format. 

Below is a list of two (2) character file name additions that Power*Log / Core & Curve™ uses to 
identify different reports. For this example, a File Name of "trial" with an ASCII Disk File Format will be 
used: 
 

Report Name File Output Name Report Name File Output Name 

Title Page trialtt1.txt Well Abstract trialwa1.txt 

Survey Plan View Not available Survey Cross Section Not available 

Survey Azimuth View Not available Survey User Defined Not available 

Survey Multi View Not available Well Summary gwellsum.pdf 

Daily Drilling Summary trialdr1.txt Casing Strings trialcs1.txt 

Bit Record Summary 
(IADC) 

trialbs1.txt Bit Record Summary (TBG) trialbd1.txt 

Bit Record Summary trialbr1.txt Core Plugs trialcp1 

Core Descriptions  trialcd1.txt Core Description / Report 
Core Header 

trialct1.txt 

Logging Reports triallg1.txt Test Reports trialts1.txt 

Directional Surveys trialsv1.txt Directional Survey Points trialsp1.txt 

Deviation Survey Points trialds1.txt Master Survey Group trialmg1.txt 

Mud Data trialfl1.txt Abandonment Plugs trialpg1.txt 

Work Schedule trialwk1.txt Formation Tops trialtp1.txt 

Formation Evaluation trialfm1.txt Sample Descriptions trialst1.txt 

Sample Description / 
Tops 

trialfs1.txt Sidewall Cores trialsw1.txt 

Core Plugs trialcp1.txt MDT Run trialmdt1.txt 

Geology Dictionary trialgd1.txt Table of Contents trialtc1.txt 
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Below is a list of the file names that Power*Log / Core & Curve™ uses to identify different reports for 
the pdf printer selection. For the file names below you will see the Crystal Reports - before every file 
name: 

Report Name File Output Name Report Name File Output Name 

Title Page wendttle.pdf Well Abstract abstract.pdf 

Survey Plan View Survey Plan 
View.pdf 

Survey Cross Section Survey Cross 
Section.pdf 

Survey Azimuth View Survey Azimuth 
View.pdf 

Survey User Defined Survey User 
Defined.pdf 

Survey Multi View Survey Multi 
View.pdf 

Well Summary gwellsum.pdf 

Daily Drilling Summary drillsum.pdf Casing Strings casing.pdf 

Bit Record Summary 
(IADC) 

bittable.pdf Bit Record Summary (TBG) bittabdb.pdf 

Bit Record Summary bitrec.pdf Core Plugs corplug.pdf 

Core Descriptions  fcordsc.pdf Core Description / Report 
Core Header 

fcortext.pdf 

Logging Reports logging.pdf Test Reports test.pdf 

Directional Surveys survey.pdf Directional Survey Points survpnts.pdf 

Deviation Survey Points survptss.pdf Master Survey Group msurvpnt.pdf 

Mud Data fluid.pdf Abandonment Plugs plug.pdf 

Formation Tops tops.pdf Work Schedule worksch.pdf 

Sample Descriptions samptext.pdf Formation Evaluation formaton.pdf 

Sidewall Cores sidewall.pdf Sample Description / Tops fsmptext.pdf 

MDT Run MDT.pdf Geology Dictionary geodict.pdf 

Table of Contents wendtoc.pdf   

**The  button, in the upper right corner of the Print Well End Report window, will take you 
to the Print Morning Report window. ** 

Note: Upon closing the Print Well End Report window, you will be asked if you want to save the print 

configuration. If you click on  button, the program will remember every setting that you 

made to the window and will default to these settings the next time you enter the Print Well End Report 

window. 

Print “Well End and AM” Reports to Word Format 

This printing method has been implemented to facilitate the printing of the 
Geological reports to a different format other than the Crystal Reports 
generated to this point in time. Most of the reports are very similar but are 
not just text fields that our users have had some problems with when they 
are printed to word format. This new geration of reports should be easily 
formatted to their particular reporting format. 
 
Click on Print Reports to Word, under the File menu selection, to activate the 
Print Reports to Word window shown below. The user can also click on the 

Shortcut button  located on the toolbar. 
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Overview of Well End Reports Tab Window 

Prepared For Fields are to be filled in for the Title page report. Type in 
the Company Name you are working for in the company field and the 
Person’s name you are working for or is receiving the reports in the 
Name field 

 
Prepared By Fields are to be filled in for the Title page report as 
well. Type in your Company Name in the company field and your 
name in the Name field 
 

 This field defaults to the well 
that is open when you enter into this application. The user can utilize the drop arrow to pick any well they 
have in their database. 

The Depth Range fields are available to print a portion or depth interval of 
the Sample or Core descriptions as well as Devon Malibu Format Moring 
Reports. Leave these fields blank to print them all. 

Activate this check box if you 
want to include the 
Formation tops in the Sample 
or Core Descriptions report. 

 
This field gives the user to 
identify which well end 
reports they would like to 
print  and they can also 
identify multiple reports to 
print at once. Click on the 
report name to activate or 
highlight the report to be 
printed and Click again to 
deactivate the report. 
Scroll through the list to 

identify which reports you wish to print. 
 
Activate this check box if you wish to 

print multiple reports to a single file. Or conversely 
deactivate this check box if you want multiple files 
created. 

This button will highlight all the reports 
and you can activate the reports you 
do not wish to print. 

This button will deselect all the reports 
and you can activate the reports you wish to print. 

This button will activate the printing process and create either single or multiple files. The 
documents created will be Document 1 Document 2 etc. 
 

How to Print Well End Reports to Word Format. 

1. Click on Print Report to Word, under the File menu selection, to activate the Print Reports to 

Word window. The user can also click on the shortcut  button located on the toolbar. 
2. Choose the well you wish to create a report for from the selection box if the default well is not the 

one you want to print. 
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3. Highlight the reports you wish to print in the Reports field by clicking on them once. To 

select/highlight all of the reports, click on the  button. To deactivate all of the 

reports, click on the  button. . If you are printing sample or core Descriptions 
select if you wish to print tops or all the descriptions. 

4. Click on the  button to create the reports. This will activate your copy of MS Word 
application and you can view, customize and save these reports. 

 

Overview of Morning Reports Tab Window 
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This field defaults to the well that is open when you enter into this application. 
The user can utilize the drop arrow to pick any well they have in their 
database. 

 

 
This field gives the user the ability to identify which Morning reports date they 
would like to print. The user has the ability to print one or more report dates. 
Select or deselect them by clicking on them once. 
 
 
 
 
 
 

 
This identifies which portion of the report they would like to print. The choices 
will be activated with a check box. This information is entered into the Morning 
reports located under the Reports pull down menu in Power*Log / Core or 
Curve. 
 

 
 
 
This gives the user the ability to pick and choose which of the Well 
End reports they would like to include with the printed am report. 
They include Bit records Casing Formations and Surveys. All 
these records default to the depth interval from the previous 
morning report but can be modified by the user. 
 
 
 
 

 
 

When the user clicks on the  this activates the Set depth 
range window so the user can decide what ranges of well end report data 
to include with the AM report printing. The default is the depth from the 
previous Am report and the one you have selected to print. 
 
 
 

Activate this check box if you wish to print multiple report 
dates to a single file. Or conversely deactivate this check box if you want multiple files 
created. 

 
This button will highlight all the am report dates. 

This button will deselect all the am report dates. 

This button will activate the printing process and create either single or multiple files. The 
documents created will be Document 1 Document 2 etc. 
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How to Print Morning Reports to Word Format. 

 
1. Click on Print Report to Word, under the File menu selection, to activate the Print Reports to 

Word window. The user can also click on the shortcut  button located on the toolbar. 
2. Click on the Morning Reports tab to activate that portion of the window. 
3. Choose the well you wish to create a report for from the selection box if the default well is not the 

one you want to print. 
4. Highlight the report dates you wish to print in the Dates field by clicking on them once. To 

select/highlight all of the reports, click on the  button. To deactivate all of the reports, 

click on the  button. 
5. Select the report options from the appropriate check boxes. 
6. Select from the Single Report Options which data from the well end reports you would like to 

include in this printed AM report. 
7. If you have selected some Well End report data to be included with the AM report printing and you 

would like to change the default depths to search for a different interval of data then you would Click 

on the  button to activate the window and change the depths accordingly. 

 

8. Click on the  button to return to the main window. 

9. Click on the  button to print the AM report to word format. This will activate your copy of 
MS Word application and you can view, customize and save these reports. 
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File Menu – Survey View Module 
This module allows the user to view a single well or multiple wells in 
multi view angles. We give the user the ability to zoom in or out as well 
as up or down and view the well path in four (4) separate views. The 
views are Plan view (from the top), Vertical Section view (parallel to 
the target azimuth), Cross Section view (right angles to the target 
azimuth) and a User Defined view where the user can spin the view to 
any angle they wish. Each view can be captured separately or the 
capture can be taken of all four views at once. The screenshots taken 
in this module can then be printed with the striplog and the well end 
report. 

Note: The user only has to fill in the metes and bounds for a 
single well but you must fill in the longitude and latitude fields for 
all subsequent well plots. The subsequent wells must be within a 
reasonable distance from the original well for it to plot. 

Operating Procedures 

1. Click on the Survey View  Icon on the Toolbar OR go under 
the File Menu in Power*Log / Curve / Core and select the 
Survey Viewer. This will activate the Survey View window shown 
below. 
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Note: It is important to know some of the well location information before proceeding with step 1. If you 
are in the DLS land survey system you should know the metes and bounds for the surface hole coordinate 
values and if you are in the NTS survey system you should know your surface hole location identification. 
If you are adding a second well to the view you must know the longitude and latitude of the surface hole 
location in degrees, minutes and seconds down to 3 decimal places 

New Survey Selection – This selection allows the user open a set of surveys for a well (both prognosis 
and actual surveys) and see them plotted in the 4 views available. 
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How to Open a set of Surveys for a well. 

1) This will activate the survey view window shown above. Click on the  New Survey button on the 
toolbar or click on New Survey from the File menu selection to activate the Select Survey to Plot 
window. 

            

 

2) Click on the + beside the Surveys to expand the list of surveys that are in the database and then 
select the well by highlighting it with the mouse pointer. Then you will want to enable the check box 
and fill in the DLS coordinates or the NTS values as indicated in the window shown below. If your 
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survey system does not fall into these survey systems then leave them unchecked and your well will 
be in the centre of a generic grid system as viewed in the Plan and user defined views. Then click on 

the  button to activate the survey view window with your surveys from this well. 

DLS Example 

   

The surface hole Longitude and Latitude fields to not have to be filled in if this is the first well to plot in the 
survey view application. Any subsequent well data to be displayed the user must fill in the surface hole 
well co-ordinates for both Latitude and Longitude in degrees minutes and seconds and we will utilize 
these fields to get subsequent well data onto the plot. If you enable the check box beside the DLS your 
Plan view and User-defined view will have the DLS grid system marked. The DLS Survey breakdown 
would be as follows for this example location 

09-26-001-28 W1M. Where the 09 is the Location, 26 is the Section, 001 is the township and 28 is the 
range and the 1 is the meridian 

The Meters North of the South Boundary must be 
just that. If your survey plat gives you from the north 
boundary, then you have to subtract that number 
from 1,609.34 m to give you the meters North of 
South Boundary. The Meters East of the West 
Boundary must be just that. If your survey plat 
gives you from the east boundary, then you have to 
subtract that number from 1,609.34 m to give you 
the meters East of West Boundary. The Road 
Allowance field (these are dead areas in the DLS 
grid system) is traditionally the default value (20.12) 
but can in some places (30.18). The Township field 
(Values from 1 to 126) depends on the well location. 
It is necessary because we have to accommodate 
for correction lines if your well crosses those on the 
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plan or user defined views. The Section field (Values 1-36) depends on the well location. It is necessary 
because we have to accommodate for road allowances if your well crosses those on the plan or user 
defined views 

3) Click on the  button. If done correctly and you have sufficient surveys you should get the 
survey window filled in with the four (4) views of your well bore. You should see something similar to 
one of the Survey window shown above. 

NTS Example 
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If you enable the check box beside the NTS your Plan view and User-defined view will have the NTS 
grid system marked. 

Below is an example of the NTS survey system location. Remember we are dealing with the surface 
location. 

Below is an example of the NTS survey system location. Remember we are dealing with the surface 
location. 

a-18-D / 94-A-13 whereas a is the ¼ Unit, 18 is the Unit, 
D is the block, 94 is the series, A is the Area and 13 is 
the sheet. 

Fill in the surface location fields from the surface location 
given to you in the survey plat. In this NTS system we can 
use any corner for the measurements on the surface 
location but you must pick one from the drop box Then fill 
in the Meters from the North / South Boundary. Then fill 
in the Meters from the East / West Boundary. If you are 
adding multiple wells then you must also fill the surface 
hole Longitude and Latitude fields to not have to be 
filled in if this is the first well to plot in the survey view 
application. Any subsequent well data to be displayed the 
user must fill in the surface hole well co-ordinates for both 
Latitude and Longitude in degrees minutes and seconds 

and we will utilize these fields to get subsequent well data onto the plot. 

Fill in the surface location fields from the surface location given to you in the survey plat. In this NTS 
system we can use any corner for the measurements on the surface location but you must pick one from 
the drop box Then fill in the Meters from the North / South Boundary. Then fill in the Meters from the 
East / West Boundary. If you are adding multiple wells then you must also fill the surface hole 
Longitude and Latitude fields to not have to be filled in if this is the first well to plot in the survey view 
application. Any subsequent well data to be displayed the user must fill in the surface hole well co-
ordinates for both Latitude and Longitude in degrees minutes and seconds and we will utilize these fields 
to get subsequent well data onto the plot. 

3. Click on the  button. If done correctly and you have sufficient surveys you should get the 
survey window filled in with the four (4) views of your well bore. You should see something similar to 
one of the Survey window shown above. 
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No Survey System 

  

If you do not enable the check boxes beside the DLS or NTS your Plan view and User-defined view will 
have a generic grid system marked and your well centre will be right in the middle of the plot. 

3. Click on the  button. If done correctly and you have sufficient surveys you should get the 
survey window filled in with the four (4) views of your well bore. You should see something similar to 
one of the Survey window shown above. 
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File Menu- Save Screen 

Save Screen Selection – This allows the user to capture and save a 
screen shot of the survey view at the time of selecting. The User can 
also Click on the Icon on the tool bar. The user can save up to five 
(5) screen shots. These screen shots can be printed along with the 
striplog in our Power*Suite applications (Log, Curve, Core) as well 
as the well end report printing module. The screen shots will be 
saved in the PowerSuite_V12/SurveyViews/UWI folder for the well. 
A screen capture of the directory structure is shown below. 
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File Menu- Connect to Database 

Connect to database Selection – This selection allows the user to connect to a PGEOLOGY V12 
database. 

1.) Click on the File Menu and Select …. Connect to Database. This will activate a Connect Database 
window. 

    

2.) Highlight the PGEOLOGY V12 METRIC (Microsoft Access Driver[*.mbd])) database by clicking 
on it once. 

3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the 
User ID field. Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to 
the Password field. 

4.) Type “pgeology” in the Password field and then click on the  button. The program will 
now load various dictionaries and then activate an Open Log window. 

File Menu- Disconnect to Database 

Disconnect from Database Selection – This selection allows the user to disconnect from a PGEOLOGY 
V12 database. 

1.) Click on the File Menu and Select …. Disconnect to Database. This will disconnect you from the 
Database. 

 

File Menu- Exit 

Exit Selection – This selection allows the user to connect exit or close 
the survey viewer application. 

1.) Click on the File Menu and Select Exit..  
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Edit Menu - Properties 

 

 

The Properties menu item allows the user to customize the look of the 
views. There is something to note here that if you make changes to one 
view they all change so beware. 

1. Click on the Properties selection under the edit pull down menu or click on the  icon on the tool 
bar. Another way to activate this menu is to right click on the view and select the properties option 
from the pop out menu. This will activate the edit window for the survey view application as 
shown on the next page. 

Overview of Properties Window 

Display Setting Tab 
 

 

 The Point Display Size setting allows the user to define the size of the survey 
points in the survey view displays. If the Point Display is not checked, it will also control the thickness of 
the line drawn to represent the well path. 

 The display Point check box changes the display from survey point balls with a thin line 
connecting the survey balls to a solid line view. 

 The display Prognosis check box setting turns on/off the set of surveys that made up the 
original prognosis and displays that information. These surveys have to be entered into the Prognosis 
portion of the survey report in our main applications (Log, Curve and Core) and then calculated. 

 The display Azimuth check box allows the user to turn on/off the target 
azimuth of the well that has to be entered into the Survey Report window. Ultimately, the master survey 
group controls this display. 



                             Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 78 

 The display Survey Text setting turns on/off survey indicators on the Plan view only and 
these indicators illustrate every 10

th
 survey point in the Master survey group. 

 The display Wireframe setting changes the survey point balls from a solid color to a wire 
frame symbol. 

 The display Formation tops check box will turn on/off the ability to display the Formation 
tops entered into Power*Log / Curve or Core and will display the Log / Sample or Prognosed tops as 
indicated in the Formation tops window. 

 The scale check box will turn on/off the 
ability to display the scale 

The Grid Walls enables the user to turn on/off the 
exterior walls of the grid system. These walls are 

displayed in three (3) of the views. These walls can be displayed in the User-defined, Target azimuth and 
Cross section views. The walls increment is defined by the scale increment of the window. 

 The corners check box turns on/off the corners connecting the grid walls. The ability to turn off 
the corners will mostly be used in the Vertical Section and Azimuth views if the target azimuth is 
tangential. 

 

This Grid Labels enables the user to control the positioning and label verbiage in two (2) of the views. 
These labels are displayed in both the Plan view and the User-defined view but cannot be controlled 
independently. The labels (in this case are North, S, East and W) are displayed in the following example. 
The E+ / W- axis is left / right with a + value moving it to the right and a – value moving it to the left. The 

N+ / S-  axis is up / down with a + value moving it up and a – value moving it down. 

The Line Sizes enables the user to change the line thickness on the Plan and user-
defined surface grid indications as well as the line thickness in the grid walls. Major 
lines encompass the exterior borders of a Section in the DLS system, a Unit in the 
NTS system and the exterior of a no survey system choice. All other lines on the views 

are minor lines. 

The Scale enables the user to control where the depth scale is 
positioned and the increment for the depth scale. The depth Scale is 
displayed in all views but the Plan view. A positive (+) value in the E+/W -
field moves the scales to the East with a negative (-) value moves the 
scale to the West. A positive (+) value in the N+/S- field moves the 

scales to the North with a negative (-) value moves the scale to the South. The Increment field allows the 

user to specify what the wall grid increment will be. The check box covered earlier will turn 
on/off the scale. 
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The Lithology Offset enables the user to control where the 
Interpretive Lithology column (displayed in TVD & Vertical 
Section) is positioned. The Interpretive Lithology column is 
displayed in all views but the Plan view. A positive (+) value in 
the E+/W- field moves the Interpretive Lithology to the East with 
a negative (-) value moves the scale to the West. A positive (+) 

value in the N+/S- field moves the Interpretive Lithology to the North with a negative (-) value moves the 
scale to the South. The Colum size field changes the width of the Interpretive Lithology displayed in the 
views. The Opacity field changes the ability to see through the column to view other data. 0 is 
transparent and 1 would be solid. 

The Log Tops enables the user to control where the Formation tops are positioned.. 
The Log Tops are displayed in all views. A positive (+) value in the E+/W -field 
moves the scales to the East with a negative (-) value moves the scale to the West. 
A positive (+) value in the N+/S- field moves the scales to the North with a negative 

(-) value moves the scale to the South. The  check box covered 
earlier will turn on/off the scale. 

 Changes the color of the Survey Points / Line and target azimuth line display. 

 Changes the background of the entire view. 

 Changes the text color for the blocks, labels and Formation Tops. 

Surface Coordinates Tab (Properties Window) 

 

This portion of the window allows the user to add the long lat for the surface hole which is necessary if 
this is an additional well to be plotted or correct the DLS or NTS portion of the window. These fields were 
entered when the survey plot was initially started. 
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The surface hole Longitude and Latitude fields to not have to be filled in if this is the first well to plot in the 
survey view application. Any subsequent well data to be displayed the user must fill in the surface hole 
well co-ordinates for both Latitude and Longitude in degrees minutes and seconds and we will utilize 
these fields to get subsequent well data onto the plot. If you enable the check box beside the DLS your 
Plan view and User-defined view will have the DLS grid system marked. The DLS Survey breakdown 
would be as follows for this example location 

09-26-001-28 W1M. Where the 09 is the Location, 26 is the Section, 001 is the township and 28 is the 
range and the 1 is the meridian 

The Meters North of the South Boundary must be 
just that. If your survey plat gives you from the north 
boundary, then you have to subtract that number 
from 1,609.34 m to give you the meters North of 
South Boundary. The Meters East of the West 
Boundary must be just that. If your survey plat 
gives you from the east boundary, then you have to 
subtract that number from 1,609.34 m to give you 
the meters East of West Boundary. The Road 
Allowance field (these are dead areas in the DLS 
grid system) is traditionally the default value (20.12) 
but can in some places (30.18). The Township field 
(Values from 1 to 126) depends on the well location. 
It is necessary because we have to accommodate 
for correction lines if your well crosses those on the 
plan or user defined views. The Section field 

(Values 1-36) depends on the well location. It is necessary because we have to accommodate for road 
allowances if your well crosses those on the plan or user defined views 

4) Click on the  button. If done correctly and you have sufficient surveys you should get the 
survey window filled in with the four (4) views of your well bore. You should see something similar to 
one of the Survey window shown above. 
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NTS Example 

 
If you enable the check box beside the NTS your Plan view and User-defined view will have the NTS grid 
system marked. 

Below is an example of the NTS survey system location. Remember we are dealing with the surface 
location. 

a-18-D 94-A-13 whereas a is the ¼ Unit, 18 is the Unit, D 
is the block, 94 is the series, A is the Area and 13 is the 
sheet. 

Fill in the surface location fields from the surface location 
given to you in the survey plat. In this NTS system we can 
use any corner for the measurements on the surface 
location but you must pick one from the drop box Then fill 
in the Meters from the North / South Boundary. Then fill 
in the Meters from the East / West Boundary. If you are 
adding multiple wells then you must also fill the surface 
hole Longitude and Latitude fields to not have to be 
filled in if this is the first well to plot in the survey view 
application. Any subsequent well data to be displayed the 
user must fill in the surface hole well co-ordinates for both 
Latitude and Longitude in degrees minutes and seconds 
and we will utilize these fields to get subsequent well data 

onto the plot. 

4. Click on the  button. If done correctly and you have sufficient surveys you should get the 
survey window filled in with the four (4) views of your well bore. You should see something similar to 
one of the Survey window shown above. 
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Edit Menu – Add Survey 

                          
 
The User can add as many survey plots (as long as they are within a few miles / kilometers from 
the original well plot. This where the Longitude and latitude for the surface hole location is 
necessary for the addition well plots to work. 

How to add a new survey plot to an existing plot. 

1) Click on the Edit menu and select the Add Survey selection from the pull down menu or 

Click on the on the toolbar. This will activate the Select Survey to plot window. 
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2) Click on the + beside the Surveys to expand the list of surveys that are in the database and then 
select the well by highlighting it with the mouse pointer. I the well has data from a previous entry click 

on the . Button. If not then you will want to fill in the DMS for the surface hole locations 

longitude and Latitude and then click on the  button to activate the survey set to the 
original view. 

3) Repeat Steps 1 – 2 to add more survey plots to your original plot. 
 

Edit Menu – Remove Survey plots 

                          
 
The User can also remove survey plots that were previously added. 

How to remove survey plots from an existing plot. 

1) Click on the Edit menu and select the Remove Survey selection from the pull down menu 

or Click on the on the toolbar. This will activate the Select Survey to plot window. 

 

 

2) Click on the wells UWI  to highlight the survey set and then  click on the . Button.  

3) Repeat Steps 1 – 2 to remove more survey plots from your original plot. 
 

View Menu 

Plan view (isolated) 

1. Click on the Plan View selection under the View pull down menu or 

click on the  icon 
on the tool bar. This will Isolate the plan view and make it bigger. 

2. The user can then use the scroll button on the mouse to zoom in or 
out of the image (up scroll to zoom out and down scroll to zoom in). The 
user can also use the up / down arrows on the keypad to move the 
image up or down or the left / right arrows on the keypad to move the 
image left or right. 

3. Click on the properties selection under the Edit pull down menu or 
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right click on the image and select properties this would 
activate the properties window where the user can change what 
is shown on the view but will be applicable to all views. 

4. Once the view is set up the way you want you can save this by 
Clicking on the 

 Icon on 
the tool bar or the Save Screen Selection under the File pull 
down menu. This will save the screen capture and give you 
the ability to print it out on your striplog in all of our applications. 

 

Toolbar Selection 

1. Click on the Toolbar selection under the View pull down menu to turn on or off the toolbar. The 
toolbar is located under the Menu selections 
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Status Bar Selection 

2. Click on the Status Bar selection under the View pull down menu to turn on or off the Status 
bar. The Status bar is located on the bottom of the Survey View window. 

 

User defined view (isolated) 

1.  Click on the User Defined View selection under the View pull down 

menu or click on the  
icon on the tool bar. This will Isolate the User Defined view and make it 
bigger. 

2. The user can then use the scroll button on the mouse to zoom in or out 
of the image (up scroll to zoom out and down scroll to zoom in). The user 
can also use the up / down arrows on the keypad to move the image up 
or down. The user can use their mouse to rotate the view by clicking and 

dragging within the view to rotate the view.  
3. Click on the properties selection under the Edit pull down menu or right click on the image 

and select properties this would activate the properties window where the user can change what 
is shown on the view but will be applicable to all views. 

4. Once the view is set up the way you want you can save 
this by Clicking on the 

 
Icon on the tool bar or the Save Screen Selection under 
the File pull down menu. This will save the screen 
capture and give you the ability to print it out on your 
striplog in all of our applications. 
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Vertical Section view (isolated) 

1.  Click on the Vertical Section View selection under the View pull down menu or click on the 

 icon on the tool bar. This will Isolate the 
plan view and make it bigger. This view is a display of the well bore parallel with the Vertical 
Section indicated in the Survey window for the Master Survey group. 

2. The user can then use the scroll button on the mouse to zoom in or out of the image (up scroll 
to zoom out and down scroll to zoom in). The user can also use the up / down arrows on the 
keypad to move the image up or down or the left / right arrows on the keypad to move the 
image left or right. 

3. Click on the properties selection under the Edit pull down menu or right click on the image 
and select properties this would activate the properties window where the user can change what 
is shown on the view but will be applicable to all views. 

4. Once the view is set up the way you want you can save this 
by Clicking on the 

 Icon 
on the tool bar or the Save Screen Selection under the 
File pull down menu. This will save the screen capture 
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and give you the ability to print it out on your striplog in all of our applications. 

 

Cross Section view (isolated) 

1. Click on the Cross Section View selection under the View pull down 
menu or click on the 

 icon on the tool 
bar. This will Isolate the plan view and make it bigger. This view is a 
display of the well bore at right angles to the Vertical Section indicated in 
the Survey window for the Master Survey group. 

2. The user can then use the scroll button on the mouse to zoom in or 
out of the image (up scroll to zoom out and down scroll to zoom in). The 

user can also use the up / down arrows on the keypad to move the image up or down or the 
left / right arrows on the keypad to move the image left or right. In the User defined view the 
arrows do not apply but the user can use their mouse to rotate the view by clicking and 
dragging within the view to rotate the view. 

3. Click on the properties selection under the Edit pull down menu or right click on the image 
and select properties this would activate the properties window where the user can change what 
is shown on the view but will be applicable to all views. 
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4. Once the view is set up the way you want you can save 
this by Clicking on the 

 Icon 
on the tool bar or the Save Screen Selection under the 
File pull down menu. This will save the screen capture 
and give you the ability to print it out on your striplog in all 
of our applications. 

 

Multi Views 

1. Click on the Multi Views selection under the View pull down menu or click 

on the  icon on the 
tool bar. This will Isolate the plan view and make it bigger. This view is a 
display of the well bore at right angles to the Vertical Section indicated in the 
Survey window for the Master Survey group. 

2. The user must first click on the view he wishes to modify. In 3 of the 4 
(except for User Defined) views the user can then use the scroll button on 
the mouse to zoom in or out of the image (up scroll to zoom out and down 

scroll to zoom in). The user can also use the up / down arrows on the keypad to move the 
image up or down or the left / right arrows on the keypad to move the image left or right.  
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3. Click on the properties selection under the Edit pull down menu or right click on the image 
and select properties this would activate the properties window where the user can change what 
is shown on the view but will be applicable to all views. 

4. Once the views are set up the way you want you can save this by 
Clicking on the 

 Icon on 
the tool bar or the Save Screen Selection under the File pull 
down menu. This will save the screen capture and give you the 
ability to print it out on your striplog in all of our applications. 

 

Window Menu 

New Window 

Use this command to start a new Auto Import Log. 

The user must click on New located under the Windows menu selection on the main window to arrange 
multiple log history windows in a cascading manner. 

Cascade 

Use this command to arrange multiple opened windows in a non-overlapping, top to bottom fashion. 
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The user must click on Cascade located under the Windows menu selection on the main window to 
arrange multiple log history windows in a cascading manner. 

Tile 

Use this command to arrange multiple opened windows in a non-overlapping, side-by-side fashion. 

The user must click on Tile located under the Windows menu selection on the main window to arrange 
multiple log history windows in a tiled manner. 

Arrange Icons 

Use this command to arrange icons. 

The user must click on Arrange Icons located under the Windows menu selection on the main window 
to arrange your icons. 

Help Menu 

About Survey View 

1. The user must click on About Survey View located under the Help menu selection on the main 
window to activate the About window. 

 

2. Click on the  button to exit this window.  

Edit Menu – Well Selection 
Lets you edit existing wells, and delete a well. The majority of this information is usually filled in at 
the start of a well, but should be updated with new information at the completion of a well. 
 
The information associated with each well is entered into the Well window, along with the well's UWI 
(Unique Well Identifier). Note that each well and the information that it contains must be associated with 
a UWI (Unique Well Identifier) in order to distinguish it from the other wells residing within the 
Power*Log / Core & Curve database. However, the only way in which a well’s information can then be 
displayed is by associating it with a log and then having that log open. 

1. Click on Well, under the Edit menu selection, to activate the Well window. 
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Note: The well window has been filled in to give you an idea of how to complete the different fields. 

2. Change or add to the different fields by typing in the fields. Certain fields have restrictions to what 
data they accept. If an error occurs while saving refer to the status bar for instructions. 

3. Click on the  button or press ALT-S and the well data that you have just entered will be 
saved to the database. 

Note: The Well Name field should be highlighted after you have clicked on the  button or press 

ALT-S, as an indication of a properly saved record. Some of the fields in the Edit Well window have 

character restrictions or mandatory requirements. Consequently, if any of these restrictions have been 

violated or if any requirements have not been met, the offending field will be highlighted and the problem 

will be displayed on the Status Bar, at the lower left hand corner of your screen. Remember to save your 

work again, after the problem has been rectified. 

4. If the record has been successfully saved, click on the  button, when prompted with 
the Shortcut Options system window. 

Field Restriction Table: 
 

Bottom Hole Latitude 60 Character Optional 
Bottom Hole Longitude 60 Character Optional 
Bottom Hole EW 100 Character Optional 
Bottom Hole NS 100 Character Optional 
Intermediate Casing EW 100 Character Optional 
Intermediate Casing NS 100 Character Optional 
Intermediate Casing Latitude 60 Character Optional 
Intermediate Casing Longitude 60 Character Optional 
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Casing Flange Elevation 5.5 Numeric Optional 
Country 50 Character Optional 
County 50 Character Optional 
Cut  5.5 Numeric Optional 
Driller's TD (Strap) MD 5.5 Numeric Optional 
Driller's TD (Strap) TVD 5.5 Numeric Optional 
Driller’s TD (Tally) MD 5.5 Numeric Optional 
Driller’s TD (Tally) TVD 5.5 Numeric Optional 
Drilling Contractor 50 Character Optional 
Field (Assigned Field) 50 Character Optional 
Fill  5.5 Numeric Optional 
Ground Elevation 5.5 Numeric Optional 
Hole Direction  12 Character Optional 
Hole ID 15 Character Optional 
KB Elevation 5.5 Numeric Optional 
KB to Ground 5.5 Numeric Optional 
Licensee 50 Character Optional 
Surface Hole Location 50 Character Optional 
Bottom Hole Location 50 Character Optional 

Logger’s TD MD 5.5 Numeric Optional 
Logger’s TD TVD 5.5 Numeric Optional 
Operator 50 Character Optional 
Plugback Depth 5.5 Numeric Optional 
Province/State 50 Character Optional 
Reference Elevation 12 Character Optional 
Rig Release Date DATE FORMAT_24:00  Optional 
Spud Date DATE FORMAT_24:00  Optional 
Storage Units 12 Character Mandatory 
Surface EW 100 Character Optional 
Surface NS 100 Character Optional 
Surface Latitude 60 Character Optional 
Surface Longitude 60 Character Optional 
T.D. Date DATE FORMAT_24:00  Optional 
UTM East Coordinates 11.2 Numeric Optional 
UTM North Coordinates 11.2 Numeric Optional 
UWI 20 Character Mandatory 
Water Depth 5.5 Numeric Optional 
Water Depth Reference 4 Character Optional 
Well Abstract 40000 Character Optional 
Well Name 50 Character Mandatory 
SideTrack Depth 5.5 Numeric Optional 
Well Status 100 Character Optional 

View Menu – Depth View Mode 

Depth View Mode 

 
Changes the depth view of Power*Log or Power*Curve according to your needs. The Power*Log 
or Power*Core lithology logs can be viewed and printed in Measured Depth, Subsea Level or True 
Vertical Depth. The Power*Curve lithology log can be viewed and printed in Measured Depth, 
Vertical Section (along the calculated target azimuth) or Open Hole Depth (calculated from last 
casing data entry report window). These views are dependant on whether you have survey data 
entered and if you have calculated or entered in the TVD / Vertical Section fields in the Survey 
points window. There are two ways to change your depth views. They are both outlined below. 
 
Procedure 1 
 
1. Click on Depth View Mode, under the View menu selection to activate the pop out menu and then 

click on the desired depth view to display the active log in MD (Measured Depth), TVD (True 



 Addendum User Manual Version 12 
 

Addendum Manual Version 12, page 93 

Vertical Depth), SSL (Sub Sea Level Depth) for Power*Log and Power*Core. In Power*Curve you 
will have the option to select from the desired depth view to display the active log in MD (Measured 
Depth), VS (Vertical Section Depth) or OH (Open Hole Depth). This will change the logs screen 
presentation. You will notice that the depth layer shows the depths with either an “m or ft” followed by 
“(ssl)” in subsea level view, “(tvd)” in true vertical depth view, “(vs)” in vertical section view or “(oh)” in 
open hole depth view. 

 

Note: The SSL, TVD, VS, and OH views are calculated from the directional surveys entered into the wells 
data. You must also have the KB elevation if you wish to view the log in the SSL view. The user has the 
ability to setup the master survey group information from the existing survey sets they wish to utilize for 
these views. 

Procedure 2 

 

1. Click on the down arrow on the  in Power*Log/Core and  in Power*Curve Depth 
View mode selection on the Selection Bar and select the desired depth view for your Log. 

 

Note: Once SSL, TVD, VS or OH is activated the mouse pointer now indicates the view mode 
you are in as well as the measured depth that the mouse pointer is now pointing at. 
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Reports Menu – Core 
 
Well Core information is entered into the window shown below. This information fills in the header 
of the Core Report and indicates the location of a cut core on the Core layer. 
 
The actual Core Descriptions are entered into the Core Description window, located in the lower left 
corner of the Well Core Report Window. These Core Descriptions will then be used in the Well End 
Report print window’s “Core Report”, if the Core Description Interval (To) and Interval (From) depth 
values fall between the top and bottom of the cored interval. 
 

Note: The Core Report will not print out, until you have completed at least one (1) Core Description that 
falls between the Core’s Interval (To) and Interval (From) depth values. 

 

 
 

Note: The Recovered field should be filled in with a Recovery Length and not a Percentage. The 
percentage is calculated for you on the final report and on the Core layer on the log. 

Adding a Core 
 
1. Click on Core under the Reports menu selection. 
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2. Click on the  button or press ALT-N in the Well Core Window shown above and then fill in the 
report window with your data. 

3. The Cored interval is displayed on the log in the Core layer. The default cored interval is black. If the 
user wishes to change the color left click the color swatch and pick a new color. 

N.B. The default Core interval color will now be that color. Each record has its own color so if you are 
editing the color for one you will have to edit the color for all exiting records. 

4. When you have finished adding your data, Click on the  button or press ALT-S and then click 
on the appropriate button when prompted with the Shortcut Options system window. 

Editing a Core 

1. Click on the  button to view a list of Cores to date and then double click on the record that 
you wish to edit.  

2. Or, use the database navigational tools  to navigate through the records. See 
the Database Navigational Tools section later in this User Manual for more information.  

3. Once the selected interval is displayed in the Well Core window, make any changes you feel are 

necessary. Click on the  button or press ALT-S and then click on the appropriate button 
when prompted with the Shortcut Options system window. 

Deleting a Core 

1. Click on the  button to view a list of Cores to date and then double click on the record that 
you wish to delete. Once the selected record is displayed in the Well Core window, click on the 

 Delete button. 

2. Or, use the database navigational tools  to navigate through the records. See 
the Database Navigational Tools section later in this User Manual for more information. Select the 

record you wish to delete and it will be displayed in the Well Core window. Then, click on the  
Delete button.  

3. The user will be prompted with a confirmation “Do you really want to delete?” Click on the 

 button. 

Field Restriction Table: 

Core Number 20 Character Mandatory 

Coring Date DATE FORMAT  Optional 

Top Depth 5.2 Numeric Mandatory 

Base Depth 5.2 Numeric Mandatory 

Recovered (meters) 5.2 Numeric Mandatory 

Core Outside Diameter 5.3 Numeric Optional 

Hole Size 5.3 Numeric Optional 

Formation  50 Character Optional 

Coring Company 50 Character Optional 

Service Rep. 50 Character Optional 

Bit Make 15 Character Optional 

Bit Type 10 Character Optional 

Bit Serial Number 15 Character Optional 

Bit Size 5.3 Numeric Optional 

Remarks 40000 Character Optional 

Digital Curve 30 Character Optional 
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Reports Menu – Survey Prognosis 
Information regarding the Prognosed Drilling of the well that was first designed by the Directional 
Drilling Contractor which will be followed during the drilling of the well. This report is designed to 
get the designed or prognosed well path into the Survey View application so there is some 
comparison between the actual well path and the prognosed well path. The Survey Group data is 
captured into this window.  

 
 

N.B. The only data that is required in this window is the Survey group ID and you should identify it well 
as you will probably have to use the Import Survey Tool to import all the relative survey data or you will 

be typing a lot of data into the survey points into the Survey Points window. 

The Survey Points can be added through the  button or directly through the 
Directional Survey layer Toolbox. It would probably be easier to import the surveys from a *.csv 
file format.  

Adding a Directional Survey Group 
1. Click on Survey Prognosis under the Reports menu selection.  

2. Click on the  button or press ALT-N. 
3. Type in a Survey group ID in the Survey Group field. In the example above we have used Prog and 

then click on the  button or press ALT-S and then click on the appropriate button when 
prompted with the Shortcut Options system window. 
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Directional Survey Point Window 

This window can only be accessed through the Survey Prognosis Report window, the Well window. 
Directional Surveys can be imported from ASCII files supplied by Directional Drillers. If they only have an 
Excel spreadsheet is must be first saved as a *.csv file format that can then be imported into the Prog 
Survey group or whatever character you supplied for the Survey Pronosis. 
 

 
 
Use the Database Navigational Tools to scroll through the existing records or click on the Measured 
Depth button to view a list of the survey points, that already exist within the database. 

Adding a New Record 
1. Click on Directional Survey under the Reports menu selection. Then click on the 

button to activate the Directional Survey Point window shown above. 

2. Click on the  button or press ALT-N. 
3. Enter any appropriate information into the empty fields. 

Note: You must type in all the data except for Dog Leg Severity which is not applicable to the Survey 
Views application. 

4. Click on the  button or press ALT-S and then click on the appropriate button when prompted 
with the Shortcut Options system window. 

Editing a Directional Survey Point 

1. Click on the  button to view a list of Directional Survey Points to date and then 
double click on the record that you wish to edit.  

2. Or, use the database navigational tools  to navigate through the records. See 
the Database Navigational Tools section later in this User Manual for more information.  

3. Once the selected interval is displayed in the Directional Survey Point window, make any changes 

you feel are necessary. Click on the  button or press ALT-S and then click on the 
appropriate button when prompted with the Shortcut Options system window. 

Deleting a Directional Survey Point 

1. Click on the  button to view a list of Directional Survey Points to date and then 
double click on the record that you wish to delete.  

2. Or, use the database navigational tools  to navigate through the records. See 
the Database Navigational Tools section later in this User Manual for more information. Select the 
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record you wish to delete and it will be displayed in the Directional Survey Point window. Then, 

click on the  Delete button.  
3. The user will be prompted with a confirmation “Do you really want to delete?” Click on the 

 button. 

Display Tab 

 

Arrowed Subintervals - This check box  when activated will indicate the top and bottom of your 
subintervals (portion of an interval) with an arrow rather than a set of symbols. An example is shown 
below. 
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 Normal Subintervals Arrowed Subintervals 

Transparent - This check box  when activated, this function makes the background of the accessory 
symbols transparent, so that the bed in the background shows through. If deactivated, a white 
background surrounds the accessory symbols in order to separate them more from the beds. 

Use Global Symbols – With the ability to edit existing metafiles the user may have imported a well that 
has used metafiles or symbols that have been modified to look differently than the one existing within 
your system symbols. If you wish to use your symbol set instead of the revised imported ones you can 

select this check box  to make that change. 

Interbed Line Display Type - This check box  when activated will display the interbed data with a line 
display splitting the two lithology types or when unchecked will display the lithology in an interbed fashion 
as displayed below. 

                      

Curve Backup fill – This check box  when activated will show a sideways hatching fill pattern when a 
curve goes off scale or in the backup mode. If unchecked there will be no hatching pattern when the 
curve goes off scale. 

Frequency @ 1:240 – This drop box determines how often symbols are drawn on a Lithology Layer, 
with the scale of 1:240. For example: 1 symbol every 1 meter at 1:240, 2 symbols every 1 meter at 1:120, 
1 symbol every 2 meters at 1:480, and so on. These frequencies are only in effect if you utilize the entire 
interval in Oil Shows, Rounding, Sorting, Framework, or designated an interval in Sedimentary 
Structures, Traces Fossils and Rock Accessories. 

Lithology Profile - This check box  when activated will fill in the Carbonate Texture and Grain Size 
layers with the interpretive lithology. It will draw the lithology to the maximum size filled in over the 
interval. 
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Note: The user may wish to turn off the track borders when this option is selected. You will see an 
example of this shown below. 

 

Grain Size Scale List box - You may choose between Wentworth, Canstrat or 
Amstrat scales, when using the Grain Size Builder. The Wentworth Grain size only 
allows full grain size while Canstrat / Amstrat allow half grain sizes when drafting in 
the Grain size and matrix layers. 

 This  radio button will display the Grain Size Track header with the equivalent verbal 
grain sizes such as such as C slt, VF snd, F snd, M snd, C snd etc. 

 Verbal Scale    MM Scale     

 This  radio button will display the Grain Size Track header with the equivalent numeric 
grain sizes (in mm) such as .0625, .125, .25, .5, 1, 2 etc. as shown above. 

 This  radio button will display the grain size with strait edges and right angles between 
the grain sizes. The illustration below is shown with Lithology Profile activated. 

 Hard Edges        Soft Edges      

 This  radio button will display the grain size with curved edges and rounded angles 
between the grain sizes. 

Grain Size  This drop box allows the user to select a 
hatching pattern when using the Grain Size Layer with the Lithology Profile not activate. 

Grain Size  This color selector allows the user to pick the line color (foreground) when 
the fill pattern option is used. The background color is found in the Layer configuration for the Grain Size. 
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 Grain Size No Pattern Hard edges Grain Size Pattern Soft edges 

Carbonate Texture  This drop box allows the user to 
select a hatching pattern when using the Carbonate Texture Layer with the Lithology Profile not activate. 

Carbonate Texture  This color selector allows the user to pick the line color 
(foreground) when the fill pattern option is used. The background color is found in the Layer configuration 
for the Carbonate Texture Layer. 

Carbonate Textures  This  radio button will display the grain size with strait edges and 
right angles between the Carbonate Textures. The illustration below is shown with Lithology Profile 
activated. 

Carbonate Textures  This  radio button will display the grain size with curved edges and 
rounded angles between the Carbonate Textures. 

-When this check box  is activated the bedding contacts 
(lines) between the drawn lithology types in the Interpretive Lithology Layer will be shown. 

 When this check box  is activated it will turn on the 
accessories in the Interpretive Lithology Layer. 

Monitor Height - This option allows you to scale your monitor for Power*Log / Core so you may correlate 
on-screen wells with hard copy logs that you may have. It is recommended that you take an opportunity to 
measure the vertical viewing area of your monitor in inches and then insert that value in the Monitor 
Height field. Be aware, however, that if you adjust the screen height knob on your monitor, this will affect 
the monitor height setting. 

Monitor Width - This option allows you to scale your monitor for Power*Curve so you may correlate on-
screen wells with hard copy logs that you may have. It is recommended that you take an opportunity to 
measure the horizontal viewing area of your monitor in inches and then insert that value in the Monitor 
Width field. Be aware, however, that if you adjust the screen width knob on your monitor, this will affect 
the monitor width setting. 

Note: You must restart Power*Log / Core & Curve for the Monitor Width / Height changes to take 

effect. 

This drop box option will display your directional surveys on your 
log in either Quadrant format N 62 º W) or Azimuth format (AZ 298 
º) 

Display TVD This check box  when activated will display the True Vertical depths for the survey points. 

Display SSL This check box  when activated will display the Subsea level depths for the survey points. 
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 This check box  when activated will display the Sidewall Core 
Run & Core numbers above the core triangle indicator on the Sidewall Core layer. 

Log Layers 

All Log layers - Link Layer 

This is available in any layer on the right click menu. It gives the user the ability to add a link any 
file and will open if it has a windows compatible application. 

 

How to Add a Link to any Layer 

1. Right Click on any layer and you will get (at a minimum) this pop out menu options. If the builder was 
open you would probably get more options. 

2. Select  Add / Edit / Open Link and if no Link exists you will get an Empty Links Window as shown 
below with the Depth field filled in with the depth you right clicked at. 

 

3. Click on the  button to locate the file you want to link to the layer. This will activate the Select 
file to Link to window shown below 

 

4. Navigate to the file you wish to link to your log and Highlight the file name and then click on the 

 button. This will fill in the Links window with the file name and path portion of the Links 
window as shown below. 
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5. Type in any Remarks in the Remarks field that you want to explain the link and then Click on the 

 button or press ALT-S and then click on the appropriate button out of the ensuing 

Shortcut Options window. You will now see a paperclip symbol on the layer. 

N.B. If the well is then Exported (Data Transfer Module) creating an *.exp file and then Imported (Data 
Transfer Module) the data files and links imbedded into the Original Log are then redirected and inserted 
into into the install folder for Power*Suite. The default install folder structure would be 
C:\PowerSuite_V12|Linked_Files with the original name of that file. 

How to Edit a Link to any Layer 

1. Right Click on any track / layer where you see a paperclip symbol and you will get (at a minimum) 
this pop out menu options. 

 

2. Select  Add / Edit / Open Link and if a Link exists you will get a Links Window as shown below with 
the fields filled in. 

 

3. Click on the  button to locate a different file you want to link to the layer. This will 
activate the Select file to Link to window shown below 
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4. Navigate to the file you wish to link to your log and Highlight the file name and then click on the 

 button. This will fill in the Links window with the file name and path portion of the Links 
window as shown below. 

 

5. Change the Remarks in the Remarks field that you want to explain the link and then Click on the 

 button or press ALT-S and then click on the appropriate button out of the ensuing 
Shortcut Options window. 

How to Delete a Link to any Layer 

1. Right Click on any track / layer where you see a paperclip symbol and you will get (at a minimum) 
this pop out menu options. 

 

2. Select  Add / Edit / Open Link and if a Link exists you will get a Links Window as shown below with 
the fields filled in. 
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3. Click on the  button. This will activate a Confirmation Message window. 

 

4. Click on the  button. 

Bit Record Layer 

This layer allows you to display some of the Bit Record information on the log. 

Adding Bit Record Data 

1. Double click on the Bit Record layer to activate the Bit Record window shown below. The user 

can also click on Bit Record, under the Reports menu selection. 

2. Click on the  button or press ALT-N and then fill in the report window with your data. 

3. When you have finished adding your data, Click on the  button or press ALT-S and then click 
on the appropriate button out of the ensuing Shortcut Options window. 
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Note: The Bit In information consists of Bit #, Make, and Type , while the Bit Out 
information consists of Bit #, Make, Type, Meters Drilled, Rotating Hours, and either Bit Grading 

Systems . This information is displayed on the Bit Record Layer 

To Change the Display 

1. Double Click on the Bit Record track / layer to activate the Bit Record data entry window 

2. Right click at the depth on the Bit Record track / layer where the data to change is to activate 
the pop out menu. And click on one of the selections. 

In Alignment Option – Right click on the Bit Record layer at the In depth of the bit record to change to 
activate the pop out menu seen above and select In Alignment to activate a pop out menu and select 
left / right /centre and the display will change accordingly. 

 

Out Alignment Option – Right click on the Bit Record layer at the Out depth of the bit record to 
change to activate the pop out menu seen above and select Out Alignment to activate a pop out menu 
and select left / right /centre and the display will change accordingly. 
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Moving the Bit Record Text Independently without the Right Click Options 

1. Double Click on the Bit Record track / layer to activate the Bit Record data entry window. 

2. Hold the CTRL key down on your keypad and then move the mouse to the text data you want to 
move and then click and drag the information to a new spot on the layer. If done correctly you will 
see a box outline move with the mouse and the text will be redrawn when you let go of the mouse 
button and then the CTRL key 

Note: Every type of layer in Power*Log / Core & Curve has a Data Type classification. The default 

settings for the Bit Record Data layer are shown below. To access this window, click on the  Layer 

Configuration button on the Toolbar, when the Bit Record Data layer is active. 

 

Casing Layer 

This layer allows you to display some of the Casing String information on the log. 

Adding Casing Data 

1. Double click on the Casing layer to activate the Casing Strings window shown below. The user can 

also click on Casing Strings, under the Reports menu selection. 

2. Click on the  button or press ALT-N and then fill in the report window with your data. 

3. When you have finished adding your data, Click on the  button or press ALT-S and then click 
on the appropriate button out of the ensuing Shortcut Options window. 
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Note: The information entered into the String Type, Casing Size and the depth landed 
information is the data represented in this track / layer. 

To Change the Display 

1. Double Click on the Casing track / layer just above the data to activate the Casing Strings data 

entry window. If the record is not showing then you want to click on the  button to activate 
the list of casing strings and select the casing string you want to make changes to. 

2. Right click above the string landed depth on the Casing track / layer to activate the pop out 
menu. And click on one of the selections. 

                

The example above has the Short form and casing shoe indicators at 100%. Along with a Depth layer 

Show Left Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select Show left to toggle between showing the left casing 
shoe symbol on or off. 

Show Right Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select Show Right to toggle between showing the left casing 
shoe symbol on or off. 
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Abrv Option – Right click on the layer above the string landed depth with the builder open to activate the 
pop out menu seen above and select Abrv to toggle between long and short forms of the Casing Type. 

Text Left Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select Text Left to place the text on the left of the layer. 

Text Right Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select Text Right to place the text on the right of the layer. 

Text Centre Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select Text Centre to place the text on the centre of the layer. 

View Scale Option – Right click on the layer above the string landed depth with the builder open to 
activate the pop out menu seen above and select View Scale to activate the Casing View Scale window. 
The width of the track determines the size of the casing shoe symbols and to change the view scales 
from 100 to something lesser is a necessity most of the time. The user must Type in a new scale in the 

scale field and then click on the  button. 

 

Moving the Casing Text Independently without the Right Click Options 

1. Double Click on the Casing track / layer to activate the Casing Strings data entry window. 

2. Hold the CTRL key down on your keypad and then move the mouse to the text data you want to 
move and then click and drag the information to a new spot on the layer. If done correctly you will 
see a box outline move with the mouse and the text will be redrawn when you let go of the mouse 
button and then the CTRL key 

Note: Every type of layer in Power*Log / Core & Curve has a Data Type classification. The default 

settings for the Casing Data layer are shown below. To access this window, click on the  Layer 

Configuration button on the Toolbar, when the Casing Data layer is active. 

The only thing that can be modified is the Casing shoe symbol color which is handled by the foreground 
color on the Layer Display Setting tab. 
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3. Click on the  button to Exit and Save the Layer configuration settings. 

Curve Fill Layer (Well Path Option on Single Curve) 

In Power*Suite, this layer type allows you to create a visual effect with curve data. This layer will allow 
you to fill an area surrounding the well path curve (e.g. 1/2” either side of a curve). It has been designed 
to take the interpretive lithology drawn and surround the well path curve in the Horizontal (Power*Curve) 
application. It will also be beneficial when the correlational module has been perfected. The user now has 
the ability to manipulate the angle of the bedding contacts and the extent of those beds past the areas 
previously drawn. An example is shown below. 

 

How to Set the Well Path Curve Fill options 

You will need the well path curve and the well path curve scale available for the user to be able to fill in 
the options correctly. The easiest way to populate the well path curve with digits would be by calculating 
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the survey points and updating the well path curve with the digital data. Without actual survey data 
generating the well path curve this layer will not work correctly. 

Once the curve fill layer has been added to your log the user can now utilize the curve fill layer. To set the 

Curve Fill Options the user must first make the Curve Fill Layer active. To do so the user must click on a 
track containing the Curve Fill layer and then selecting the given Curve Fill layer from the 
Layer Selection List field at the far left of the Selection Bar. 

1. Double click anywhere within the Curve Fill or layer to activate the Curve Fill Options window.  

2. Click on the  button. This will activate a list of curves associated with this well. 

3. Click on the Well Path curve name to use so that it gets listed in the upper portion of the window and 

then click on the  button or double click on the Well Path curve that has been 
generated by the survey data. You will now view the curve name below the 

button. 

 

Curve Options Portion of the Window. This information is pertaining to the Main Curve and its Curve 
attributes. 

1. Click on the Pattern Type down arrow and select the correct curve pattern for the main curve. 
The default is PtoP (Point to Point). 
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2. Click on the Grid Type down arrow  and select the correct curve grid type for the main curve. 
The default is Linear. 

Fill Options Portion of the Window (1 Curve) 

3. Click on the Fill Modes – 1 Curve down arrow  and select the Well Path from these options. 

4. Type in the Width field how wide (in inches) you want the fill to be surrounding the well path curve. 
Example: If (1) is type into the width field then the fill will be ½” either side of the curve. 

5. Select between the TVD and SSL scale options. This is applicable to which curve for well path you 
are filling. 

6. Click on the Fill Patterns down arrow  and select Interpretive Lithology. 

7. Click on the  button in the Curve fill Options window. The window will close and the changes 
you have made will be reflected on the layer. 

Well Path Curve Fill Layer – Bedding Angle Contacts builder 

Once the curve fill layer has been customized to be a well path single curve option as described above to 

get to the builder the user must first make the Curve Fill Layer active. To do so the user must click on a 
track containing the Curve Fill layer and then selecting the given Curve Fill layer from the 
Layer Selection List field at the far left of the Selection Bar. 

Single Value Data Entry 

1. Double click anywhere within the Curve Fill or layer to activate the Choose Editor window. 

 

2. Click on the  button. This will activate Bedding Angle contact window. This window 
displays the lithology data that has been entered through the Interpretive Lithology builder with the 
default setting in this window as 0 degrees bedding angle and a plus minus (departure encounter) of 
10 meters. 
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Mouse Pointer method 

3.  To modify a single bed the user can either click on the bed within the layer. The bed outline will 
change from red to blue when selected and will also be highlighted with a grey color in the builder. 

4. Hold the CTRL Key down on the keypad and click on the corner or end boundary of the bed This 

will result in an  or  cursor arrow and click and drag it in a certain direction. You will see the 
outline of the bed follow your mouse. When released the bed will draw an area surrounding the curve 
within the boundaries defined by the box with the width as specified in the curve fill option window. 

Keypad Method 

5. To modify a single bed the user can either click on the bed within the layer or in the builder. The 
bed outline will change from red to blue when selected and will also be highlighted with a grey color in 
the builder. 

 

6. Here the user can change the type in a new bedding angle + or – to change the angle of dip as well 
as the extents with a (–) negative number in the Encounter Extent to further the bed to the left or a (+) 
positive number in the departure field to further the bed to the right. 

7. Click on the  button. The bed outline will be drawn in an area surrounding the curve 
within the boundaries defined by the data entered in the fields. 

Multiple Value Data Entry 

1. Double click anywhere within the Curve Fill or layer to activate the Choose Editor window. 

 

2. Click on the  button. This will activate Bedding Angle contact window. This window 
displays the lithology data that has been entered through the Interpretive Lithology builder with the 
default setting in this window as 0 degrees bedding angle and a plus minus (departure encounter) of 
10 meters. 
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3. To modify multiple beds at once the user must Type in the range of the beds as defined in the 
interpretive lithology builder (this must cover the entire interval of the bed) in the From and To fields 
that users wish to modify. 

 

4. The user can change the type in a new bedding angle + or – to change the angle of dip as well as the 
extents with a (–) negative number in the Encounter Extent to further the bed to the left or a (+) 
positive number in the departure field to further the bed to the right in their appropriate fields. 

5. Click on the  button. The beds outlines will be redrawn in an area surrounding the curve 
within the boundaries defined by the data entered in the fields. 

Note. When two beds intersect each other on this layers presentation they will be drawn with an 
interfingering pattern as shown below. 

 

Note: When you add any layer to a log, it is always associated with a Data Type. Every data type in 

Power*Log / Core & Curve has a default setting. The default settings for a Curve fill layer are shown 

below. To access this window, click on the  Layer Configuration button on the Toolbar, when the 

layer is active. 
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Depth Layer 

This layer gives the user the ability to display a depth on a track in a log. The user should have at 
least one Depth layer to identify the depth of a log. The default depth display is Measured Depth 
(MD). In Power*Log or Power*Core this layer can also represent depth as a Subsea depth value 
(SSL) or True Vertical Depth value (TVD) is the TVD Module has been purchased. In Power*Curve 
this layer can also represent depth as a Vertical Section depth value (VS) or Open Hole Depth 
value (OH) is the VS Module has been purchased. 

How to Change the Depth View on a log. 

The user must first have surveys entered into the Directional Survey Points report and they must be 
calculated. For SSL to work you must have entered the KB depth value into the Well Record. For the OH 
to work you must enter in the Casing information into the Casing report. If this information has not been 
entered or the modules have not been purchased nothing will work correctly. 

Power*Log or Power*Core Selection Bar 

 

Power*Curve Selection Bar 

 

1. Click on the down arrow beside the Depth View (MD) and Select a different view mode. If the MD 
is not grayed out you will get TVD (true vertical depth) or SSL (sub sea level) as a choice in 
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Power*Log or Power*Core. In Power*Curve you will get VS (vertical section depth) or OH (open hole) 
as a choice. 

2. or Click on Depth View Mode, under the View menu selection to 
activate the pop out menu and then click on the desired depth view to 
display the active log in MD, TVD or SSL for Power*Log and 
Power*Core. In Power*Curve you will have the option to select from 
the desired depth view to display the active log in MD, VS or OH.  

This will change the logs screen presentation. You will notice that the 
depth layer shows the depth with either an “m or ft” followed by “(ssl)” in 
subsea level view, “(tvd)” in true vertical depth view, “(vs)” in vertical 
section view or “(oh)” in open hole depth view. 

Right Click Font Orientation Menu Options on Depth Layer. 

1. On the Depth layer, right click anywhere to activate the pop-up 
menu. 

              

2. Click on Font Orientation and it will activate a pop out menu and then click on Vertical and the 
Depth font will be displayed up and down on all depth layers on all logs. 

3. Click on Font Orientation and it will activate a pop out menu and then click on Horizontal and the 
Depth font will be displayed left to right on all depth layers on all logs 

Right Click Show Units Menu Options on Depth Layer. 

1. On the Depth layer, right click anywhere to activate the pop-up menu. 

                       

2. Click on Show Units and the Depth units in the depth layer illustrated with either an m (meters) or ft 
(feet) will be turned on or off. 

NB. These depth font options can also be manipulated in the System Option located under the Option 
pull down menu in the Font Tab 

Directional Survey Points Layer  

This layer allows you to display some of the Directional Survey Point information on the log. log. 
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Adding Directional Survey Data 
1. Double click on the Directional Survey Layer to activate the Directional Survey Points window 

shown below. Or the user can also click on Directional Survey, under the Reports menu selection. 

This will activate the Survey Report then click on the  button. 

2. Click on the  button or press ALT-N and then fill in the report window with your data. 

3. When you have finished adding your data, Click on the  button or press ALT-S and then click 
on the appropriate button out of the ensuing Shortcut Options window. 

 

Note: The Directional Survey Layer has the Survey Point Information that consists of the Inclination, 
Azimuth, TVD Depth and Subsea Depth. The Azimuth can be displayed in either the 0-360 degrees or 
the Quadrant system. This option is available in the System Options, Display tab under the Options 
Menu. 

To Change the Display 

1. Double Click on the Directional Survey track / layer to activate the Directional Survey Point data 
entry window 

2. Right click at the depth on the Directional Survey / layer where the data to change is to activate 
the pop out menu. And click on one of the selections. 

 

Align Left Option – Right click on the Directional Survey layer at the depth of the directional survey 
to change to activate the pop out menu seen above and select Align Left to change the display position 
of that survey to the left. 

Align Right Option – Right click on the Directional Survey layer at the depth of the directional survey 
to change to activate the pop out menu seen above and select Align Right to change the display 
position of that survey to the right. 

Centre Option – Right click on the Directional Survey layer at the depth of the directional survey to 
change to activate the pop out menu seen above and select Centre to change the display position of that 
survey to the centre. 
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Align Left (All) Option – Right click on the Directional Survey layer to activate the pop out menu seen 
above and select Align Left (All) to change the display positions of all the surveys on the layer to the 
left. 

Align Right (All) Option – Right click on the Directional Survey layer to activate the pop out menu 
seen above and select Align Right (All) to change the display positions of all the surveys on the layer to 
the right. 

Centre (All) Option – Right click on the Directional Survey layer to activate the pop out menu seen 
above and select Centre (All) to change the display positions of all the surveys on the layer to the 
centre. 

Show TVD Option - Right click on the Directional Survey layer at the depth of the directional survey to 
change to activate the pop out menu seen above and select Show TVD to toggle between showing the 
TVD Depth or not for all the surveys. 

Show SSL Option - Right click on the Directional Survey layer at the depth of the directional survey to 
change to activate the pop out menu seen above and select Show SSL to toggle between showing the 
SSL Depth or not for all the surveys. 

Moving the Directional Survey Text Independently without the Right Click Options 

1. Double Click on the Directional Survey track / layer to activate the Directional Survey Point data 
entry window. 

2. Hold the CTRL key down on your keypad and then move the mouse to the Survey text data you 
want to move and then click and drag the information to a new spot on the layer. If done correctly 
you will see a box outline move with the mouse and the text will be redrawn when you let go of the 
mouse button and then the CTRL key 

Note: Every type of layer in Power*Log / Core & Curve has a Data Type classification. The default 

settings for the Directional Survey Data layer are shown below. To access this window, click on the  

Layer Configuration button on the Toolbar, when the Directional Survey Data layer is active. 

   

Formation Tops (Long Name) Layer 

This layer allows you to display some of the Formation Top information on the log. 

 

Adding a Formation 
1. Double click on the Formation Tops (Long Name) layer to activate the Well Formation window 

shown below. The user can also click on Formation, under the Reports menu selection. 

2. Click on the  button or press ALT-N and then fill in the report window with your data. 
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3. When you have finished adding your data, Click on the  button or press ALT-S and then click 
on the appropriate button out of the ensuing Shortcut Options window. 

 

Note: The information entered into the Formation Long Name, Prognosis TVD, Sample Top Log 
Top (MD &TVD) can be represented in this track / layer. 

To Change the Display 

1. Double Click on the Formation Top (Long Name) track / layer just above the data to activate the 
Well Formation data entry window. 

2. Right click at the depth on the Formation Top (Long Name) / layer where the data to change is to 
activate the pop out menu. And click on one of the selections. 
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Align Left Option – Right click on the Formation Top (Long Name) layer at the depth of the directional 
survey to change to activate the pop out menu seen above and select Align Left to change the display 
position of that Formation Name to the left. 

Align Right Option – Right click on the Formation Top (Long Name) layer at the depth of the 
directional survey to change to activate the pop out menu seen above and select Align Right to change 
the display position of that Formation Name to the right. 

Centre Option – Right click on the Formation Top (Long Name) layer at the depth of the directional 
survey to change to activate the pop out menu seen above and select Centre to change the display 
position of that Formation Name to the centre. 

Align Left (All) Option – Right click on the Formation Top (Long Name) layer to activate the pop out 
menu seen above and select Align Left (All) to change the display positions of all the surveys on the 
layer to the left. 

Align Right (All) Option – Right click on the Formation Top (Long Name) layer to activate the pop out 
menu seen above and select Align Right (All) to change the display positions of all the Formation 
Names on the layer to the right. 

Centre (All) Option – Right click on the Formation Top (Long Name) layer to activate the pop out 
menu seen above and select Centre (All) to change the display positions of all the Formation Name on 
the layer to the centre. 

Moving the Formation Name Text Independently without the Right Click Options 

1. Double Click on the Formation Top (Long Name) track / layer to activate the Well Formation data 
entry window. 

2. Hold the CTRL key down on your keypad and then move the mouse to the Formation text data you 
want to move and then click and drag the information to a new spot on the layer. If done correctly 
you will see a box outline move with the mouse and the text will be redrawn when you let go of the 
mouse button and then the CTRL key 

Note: Every type of layer in Power*Log / Core & Curve has a Data Type classification. The default 

settings for the Formation Top (Long Name) Data layer are shown below. To access this window, click 

on the  Layer Configuration button on the Toolbar, when the Formation Top (Long Name) Data 

layer is active. 

    

Slide / Rotate Layer 

This layer provides a visual representation of the Drill String Rotation and Orientation throughout the 
progress of the well. You can also Import the Slide / Rotate data from a slide sheet when it is saved in a 
*.csv File format. 
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The Rotate is represented as a blank space on the layer. The only thing you can physically draw on the 
layer is a Slide. This is shown as a grey bar with the letter S covering the distance of the orientation If a 
Toolface is entered into the data entry window the slide orientation is viewed. The appearance of the slide 
Toolface font is available through the right click menu option where you can align the font top / centre / 
bottom, left / centre / right, opaque, vertical or horizontal depending on your track width and log format. 

 check box allows the user to view the S’s or Tool Face Orientation in the layer display. 

 check box allows the user to view the black strip drawn in by the user. 

Drawing a Slide 
Mouse Pointer Method 

1. Double click on the Slide / Rotate track to activate the Slide / Rotate window. 
2. Position the mouse pointer at the depth on the Slide / Rotate track where the Slide begins. 
3. Click and drag the mouse pointer to the depth where the Slide ends. 
4. Release the mouse button and the Slide will be drawn accordingly. 
5. If you want to fill in the Toolface degrees and orientation, Click on the slide you just dragged, so 

that it is refreshed in the builder and then Type in the Toolface Orientation in degrees in the 
Toolface field. (180 degrees will be represented with a LS {low side} and 0 degrees will be 
represented with a HS {high side}) 

6. Select from the Right or Left Radio buttons (if applicable) 

7. Click on the  button 

8. Press the Esc key on the keyboard to exit or Click on the  Close button in the upper right 
hand corner of the builder. This will close down the Slide Rotate builder window. 

Keypad Method 

1. Double click on the Slide / Rotate track to activate the Slide / Rotate 
window. 

2. Type in a Top depth in the Top Depth field. 
3. Type in a Base depth in the Base Depth field. 
4. Type in the Toolface Orientation in degrees in the Toolface field. (180 

degrees will be represented with a LS {low side} and 0 degrees will be 
represented with a HS {high side}) 

5. Select from the Right or Left Radio buttons. (if applicable) 

6. Click on the  button. 

7. Press the Esc key on the keyboard to exit or Click on the  Close 
button in the upper right hand corner of the builder. This will close 
down the Slide Rotate builder window. 
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Deleting a Slide 
1. Double click on the Slide / Rotate track to activate the Slide / Rotate window. 
2. Right click on the Slide you wish to delete. This will activate a pop out window and select 

delete. 

3. Press the Esc key on the keyboard to exit or Click on the  Close button in the upper right 
hand corner of the builder. This will close down the Slide Rotate builder window. 

Resizing a Slide 
1. Double click on the Slide / Rotate track to activate the Slide / Rotate window. 
2. Hold down the Ctrl key on the keyboard and position the mouse pointer within the Slide 

boundary you wish to resize and you will see your mouse pointer turn into a resize cursor. 
3. Click and drag the mouse button in the appropriate direction to resize the Slide it. 
4. Release the mouse button, followed by the release of the Ctrl key on the keyboard, and the 

Slide interval will be resized accordingly. 
5. Alternatively, click on the slide (it will then be displayed into the builder) and then type in a 

new top depth or base depth (not both) and then click on the  button. 

6. Press the Esc key on the keyboard to exit from the Slide / Rotate window or Click on the  
Close button in the upper right hand corner of the builder. This will close down the Slide Rotate 
builder window 

Right Click Options for the Slide Rotate builder. 

Modifying the Display settings for the Slide / Rotate layer 

To modify the display options of an individual slide the user can right click on the slide and select one of 
these editing options. Once the options have been modified the program will remember these options for 
the next slide you draw. 

 

1. Double click on the Slide / Rotate track to activate the Slide / Rotate window. 

Delete Option - Right click on an existing slide with the builder open to activate the pop out menu seen 
above and select Delete to delete a slide. 

Display Fill Option – Right click on an existing slide with the builder open to activate the pop out menu 
seen above and select Display fill to toggle between the slide color fill and white with grey lines to 
represent the length of the slide interval. The actual color of the slide can only be changed in the Layer 
configuration window. 
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Display Text Option – Right click on an existing slide with the builder open to activate the pop out 
menu seen above and Select Display Text to toggle between the S (Slides) or the Toolface orientation if 
entered being displayed or not on the slide interval. 

Display Long Form Option - Not applicable. 

Opaque Text Option – Right click on an existing slide with the builder open to activate the pop out 
menu seen above and select Opaque Text to toggle between a white frame around the S (Slides) or the 
Toolface orientation for a better visibility or not. 

Vertical Align Option - Right click on an existing slide with the builder open to 
activate the pop out menu seen above and select Vertical Align and this will activate 
another menu and select from the top bottom centre choices and allows the user to 
determine how they want the S (Slides) or the Toolface orientation text to be aligned 
and oriented within that slide interval. 

Horizontal Align Option - Right click on an existing slide with the builder open to 
activate the pop out menu seen above and select Horizontal Align and this will activate 
another menu and select from the left right centre choices and allows the user to determine 
how they want the S (Slides) or the Toolface orientation text to be aligned and oriented 
within that slide interval. 

Vertical Orientation Option - Right click on an existing slide with the builder open to activate the pop 
out menu seen above and select Vertical Orientation which will allow the user to change the text 
orientation from up down text to left right text. 

Edit Option- Not applicable. If you want to change the color of the slide you must access the layer 
configuration and change the color there. 

 

Note: Every type of layer in Power*Log / Core & Curve has a Data Type classification. The default 

settings for the Slide / Rotate layer are shown below. To access this window, click on the  Layer 

Configuration button on the Toolbar, when the Slide / Rotate layer is active. 
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Curve Layer 

We have given the user the ability to add Hybrid Log Scales (typical for Resistivity Curves from the 
Wireline and LWD logging tools) such as scales from 0.2 to 2000 (ohmm). But we have given you the 
ability to start at any starting point on the left scale but the user has to finish the grid pattern with the 
ending point. An example of this would be 4 to 40000. We have also given the user some right click 
options to display the scale. 
We have also streamlined the Curve Scales when using an existing log template that the curve scales 
used in the template will be the defaults for the new log. 

Adding a (Logarithmic) Curve to the New Curve Layer  

 

The window displayed above allows you to adjust the properties of the Curve that is being associated 
with the layer. 

1. Select a value for the Curve Units field from the Curve Units field drop box or type in your own 
value. 

2. Set the Null Value to an appropriate number. The Null Value is a numeric value that symbolizes "No 
Data" for a particular depth point. If you have no data for a particular depth, then type in the Null 
Value for that depth and the program will read it as a 'zero' value: not attempt to draw a line to that 
data point. 

3. Enter values into the Interval (From) and Interval (To) fields that are relevant to the curve. 
Otherwise, these fields default to zero (0), as a numerical representation of the entire log. 

4. Enter appropriate values into the Scale (Left) and Scale (Right) fields. A typical logarithmic scale is 
from .1 to 10000 or can now also be a hybrid logarithmic scale such as 0.2 to 2000. 

5. Select any Backup Scale which is mandatory but is irrelevant as there is no such thing as a backup 

scale on a logarithmic curve.  

6. Click on the  button, when you have finished and the curve will be added to your log 
accordingly. 

Note: The Movable Grid, in the Layers Organizer window, is applicable to any Curve layer on your log. 

To customize your curve (grid types, curve colors, etc...), you must make the curve the active layer in the 

log and then click on Layer Configuration, under the Edit menu selection, or click on the  Layer 
Configuration button on the Toolbar. 
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Note: You are able to add curves from several other places as well: the  button in the Edit Well 

window, the button in the Curve Maintenance window, or the button in the Layer 
Configuration – Curve Definitions Tab window. All of these methods will activate the Digital Curve 
window shown below: 

Note: Once the curve is added to the curves list, you cannot access the curve for adding, editing, or 

viewing purposes, until the curve is associated with a layer. You must use the Log Configuration 

Builder – Curve Definition Tab window to associate this new curve with a layer. The only layer you may 

use is a Curve Type layer. 

Field Restriction Tables: 

Digital Curve 

Name 30 Character Mandatory 

Units 12 Character Mandatory 

Depth Units 12 Character Mandatory 

Null Value 10.5 Numeric Optional 

Remark 50 Character Optional 

Curve Scale 

Top Depth 5.5 Numeric Mandatory 

Bottom Depth 5.5 Numeric Optional 

Left 10.5 Numeric Optional 

Right 10.5 Numeric Optional 

Backup Scale 12 Character Optional 

Note: When you add a layer, it is associated with a Data Type. Every type of layer in Power*Log / Core 

& Curve has a data layer classification, so that the system knows what default settings to use when 

adding the layer to the log. To access this window, click on the  Layer Configuration button on the 

Toolbar, when the Curve layer is active. 
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Curve Layer 

Digital  Curve - Right Click Pop-Out Menu 

The digital curve pop-out menu can be accessed if the user right clicks on an active curve layer on a log. 
The user can see an example of a digital curve pop-out menu. We have added a Scale text Orientation to 
the pop out menu. 

The Scale Text Orientation Selection allows the user to change the scale text in the main body of the log 
from a Vertical Orientation to a Horizontal Orientation. Horizontal Orientation would be more applicable to 
Power*Log or Power*Core and the Vertical Orientation would be more applicable to Power*Curve 

Logarithmic Data Axis Grid Lines on Curve Layer 
Handled Here 
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